Faxing
Faxing

- Preparing for Faxing
  - Connecting the Telephone Line
  - Setting the Telephone Line Type
  - Setting the Receive Mode
  - Setting the Sender Information

- Sending Faxes Using the Operation Panel of the Machine
  - Sending Faxes with the Numeric Buttons
  - Resending Faxes (Redialing a Busy Number)
  - Sending Faxes Using Useful Functions

- Registering Recipients
  - Registering Recipients Using the Operation Panel of the Machine
  - Registering Recipients Using Speed Dial Utility

- Receiving Faxes
  - Receiving Faxes
  - Changing the Paper Settings
  - Advanced Settings of Receive Mode
  - Memory Reception
  - Receiving Faxes Using Useful Functions

- Other Useful Fax Functions
  - Using the Information Services
  - Transmission/Reception of Faxes Using ECM
  - Document Stored in Machine's Memory
  - Summary of Reports and Lists

- Sending Faxes from a Computer
  - Sending a FAX (Fax Driver)
  - Creating an Address Book (Fax Driver)
  - Edit or Remove a Recipient from an Address Book (Fax Driver)
  - Search for a Recipient in an Address Book (Fax Driver)
  - Troubleshooting Problems Sending Faxes (Fax Driver)
  - General Notes (Fax Driver)
Sending Faxes Using the Operation Panel of the Machine

- Sending Faxes with the Numeric Buttons *
- Resending Faxes (Redialing a Busy Number)
- Sending Faxes Using Useful Functions
Registering Recipients

- Registering Recipients Using the Operation Panel of the Machine
- Registering Recipients Using Speed Dial Utility
Receiving Faxes

- Receiving Faxes
- Changing the Paper Settings
- Advanced Settings of Receive Mode
- Memory Reception
- Receiving Faxes Using Useful Functions
Other Useful Fax Functions

- Using the Information Services
- Transmission/Reception of Faxes Using ECM
- Document Stored in Machine's Memory
- Summary of Reports and Lists
Sending Faxes from a Computer

- Sending a FAX (Fax Driver)
- Creating an Address Book (Fax Driver)
- Edit or Remove a Recipient from an Address Book (Fax Driver)
- Search for a Recipient in an Address Book (Fax Driver)
- Troubleshooting Problems Sending Faxes (Fax Driver)
- General Notes (Fax Driver)
Preparing for Faxing

Connect the machine to the telephone line and set up the machine before using the faxing functions. Then specify the basic setting such as sender information, date/time, and daylight saving time.

**Important**

- If the Power Disconnects Unexpectedly:
  - If there is a power failure or if you accidentally disconnect the power plug, the date/time settings will be reset.
  - The settings for user information, coded speed dial, group dial, and rejected numbers will be retained.
  - All faxes stored in the machine's memory, such as unsent and received faxes, will be lost.
- If the power disconnects, the following will apply:
  - You will not be able to send or receive faxes, make copies, or scan originals.
  - When you are connecting the telephone, whether or not you can use it depends upon your telephone line or telephone.

Setting Up the Machine

The machine must be set up depending on your telephone line and use of the faxing function. Follow the procedure below to set up the machine.

1. **Connecting the Telephone Line**
   Connect the machine to your telephone line.

2. **Setting the Telephone Line Type**
   Set the correct telephone line type for your telephone line.

3. **Setting the Receive Mode**
   Set the receiving operation (receiving mode).

**Note**

- You can set the fax setting according to the instruction on the LCD.
- Easy setup
  - If you set up according to the instruction on the LCD, the receive mode is set to **TEL priority mode** or **FAX only mode**. To receive faxes with **DRPD** or **Network switch**, change the receive mode.
- Setting the Receive Mode

Specifying the Basic Settings for Faxing

You can specify the basic setting such as sender information, date/time, and daylight saving time.

**Setting the Sender Information**
Connecting the Telephone Line

The connection method differs depending on your telephone line.

- If you connect the machine to wall telephone line directly/If you connect the machine with the xDSL splitter:
  ➔ Basic Connection
- If you connect the machine to another line such as an xDSL:
  ➔ Connecting Various Lines

If the connection is incorrect, the machine cannot send/receive faxes. Connect the machine correctly.

### Important

- Do not connect fax machines and/or telephones in parallel (US and Canada only).
  - If two or more fax machines and/or telephones are connected in parallel, the following problems may occur and the machine may not operate properly.
    - If you pick up the handset of the telephone that is connected in parallel during fax transmission or reception, the fax image may be corrupted or a communication error may occur.
    - Such services as Caller ID, etc. may not operate properly on the telephone.

If you cannot avoid parallel connections, set the receive mode to **TEL priority mode**, understanding that the above problems may occur. You will only be able to receive faxes manually.

### Basic Connection

Make sure that the machine is turned off, connect one end of supplied telephone line cable to the telephone line jack near the "LINE" mark of the machine, then connect the other end to the telephone line jack on the wall or to the telephone line jack of the xDSL splitter.

![Diagram of Basic Connection](image)

When you connect the telephone to the machine, make sure that the machine is turned off, connect one end of the modular cable to the external device jack near the "EXT." mark of the machine, then connect the other end to the telephone line jack of the telephone.

![Diagram of Modem Connection](image)

### Important

- Be sure to connect the telephone line before the machine is turned on.
  - If you connect the telephone line when the machine is turned on, turn the machine off and disconnect the power plug. Wait for 1 minute then connect the telephone line and power plug.

### Note
Connecting Various Lines
This section introduces how to connect various lines.
These are examples and could not be guaranteed to suit every connecting condition. For details, refer to the instruction manual supplied with the network device (control devices such as an xDSL (Digital Subscriber Line) modem or terminal adapter) you are connecting to this machine.

**Note**
- xDSL is the generic term for the high speed digital communication technology with telephone line such as ADSL/HDSL/SDSL/VDSL.

### Connecting to an Internet Telephone

- A. Digital Subscriber Line
- B. xDSL modem (splitter may not be built-in to the modem)
- C. Broadband router compatible with Internet Telephone
- D. Computer
- E. Telephone or answering machine
- F. WAN (Wide Area Network) port
- G. LAN (Local Area Network) port
- H. TEL port
- I. LINE port

* Port configurations and names may vary depending on the product.

**Note**
- When connecting to the xDSL line, select the same line type as you are subscribing to in Telephone line type.
  - [Setting the Telephone Line Type](#)

### Connecting to an xDSL

- A. Analog Subscriber Line
- B. xDSL modem (splitter may not be built-in to the modem)
C. Computer
D. Telephone or answering machine

**Important**

- When the splitter is not built-in to the modem, do not branch the telephone line before the splitter (wall side). And also, do not connect splitters in parallel. The machine may not be able to operate properly.

**Note**

- When connecting to the xDSL line, select the same line type as you are subscribing to in **Telephone line type**.

**Setting the Telephone Line Type**

- Connecting to an ISDN Line

For details on ISDN (Integrated Service Digital Network) connection and settings, refer to the manuals supplied with your terminal adapter or dial-up router.
Setting the Telephone Line Type

Before using your machine, make sure you set the correct telephone line type for your telephone line. If you are unsure of your telephone line type, contact your telephone company. For xDSL or ISDN connections, contact the telephone company or service provider to confirm your line type.

Note

- Telephone line type will not appear in countries or regions where Rotary pulse is not supported.
- You can print USER'S DATA LIST to check the current setting.

Summary of Reports and Lists

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the MENU button.
   - The menu screen is displayed.

3. Select Setup, then press the OK button.

4. Select Device settings, then press the OK button.

5. Use the ▲▼ button to select FAX settings, then press the OK button.

6. Use the ▲▼ button to select FAX user settings, then press the OK button.

7. Use the ▲▼ button to select Telephone line type, then press the OK button.

8. Use the ▲▼ button to select a telephone line type, then press the OK button.

 ROTARY PULSE
 Select when your telephone line type is pulse dialing.

 TOUCH TONE
 Select when your telephone line type is tone dialing.

9. Press the FAX button to return to the Fax standby screen.
Setting the Receive Mode

Set the receiving operation (receiving mode).
For details on how to set the receive mode:
⇒ Setting the Receive Mode
You can select the appropriate mode.
For details on the selectable receive mode:
⇒ About the Receive Mode

Note

- The receiving operation procedure varies depending on the selected receive mode.
  For details on receiving method depending on each receive mode:
  ➤ Receiving Faxes
- If you want to use a single telephone line for faxes and voice calls, you need to connect a telephone
  or an answering machine to the external device jack of this machine.
  For details on how to connect the telephone or the answering machine to the machine:
  ➤ Basic Connection

Setting the Receive Mode

This section describes the procedure to select the receive mode.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On
2. Press the FAX button.
   The Fax standby screen is displayed.
3. Press the center Function button.
   The Receive mode settings screen is displayed.
4. Use the ▲▼ button to select the receive mode, then press the OK button.
   The Fax standby screen is displayed.

Note

- By pressing the right Function button when a receive mode is selected, you can specify the
  advanced settings of each receive mode.
  For details on the advanced settings of the receive mode:
  ➤ Advanced Settings of Receive Mode
- If DRPD is selected, the fax ring pattern can be selected on the DRPD: FAX ring pattern
  screen.
  For details:
  ➤ Setting the DRPD Ring Pattern (US and Canada only)

Setting the DRPD Ring Pattern (US and Canada only)

If you have subscribed to a Distinctive Ring Pattern Detection (DRPD) service provided by your telephone
company, your telephone company will assign two or more telephone numbers with distinctive ring patterns
to your single telephone line, allowing you to have different numbers for fax calls and voice calls using only
one telephone line. Your machine will automatically monitor the ring pattern, and will automatically receive
the fax if the ring pattern is a fax call.

To use DRPD, follow the procedure below to set the fax ring pattern that matches the pattern assigned by
your telephone company.

Note

- Contact your local telephone company for detailed information on this service.
1. Make sure that the machine is turned on.
   ➞ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the center Function button.
   The Receive mode settings screen is displayed.

4. Use the ▲▼ button to select DRPD.

5. Press the right Function button.

6. Use the ▲▼ button to select DRPD: FAX ring pattern, then press the OK button.
   The DRPD: FAX ring pattern screen is displayed.

7. Select the ring pattern that your telephone company assigned to your fax number, then press the OK button.

![DRPD: FAX ring pattern](image)

8. Press the Back button.
   The Receive mode settings screen is displayed.

9. Press the OK button.
   The Fax standby screen is displayed.

**About the Receive Mode**

You can select the receive mode suitable for your fax use conditions: whether you use a dedicated line for fax, etc.

<table>
<thead>
<tr>
<th>Receive mode</th>
<th>Your fax use condition</th>
<th>Receiving operation</th>
</tr>
</thead>
</table>
| TEL priority mode | When mainly receiving voice calls (with a telephone or answering machine connected to the machine): | When a call incomes, the telephone will ring. 
Pick up the handset. 
If the call is a voice call, talk on the telephone. 
If the call is a fax, hang up the handset after the machine starts receiving the fax. |

**Note**

- The machine can receive a fax automatically without the handset being picked up when a call incomes (**Manual/auto switch**). And, the machine can receive a fax automatically when you pick up the handset or when the answering machine answers a call that is a fax (**User-friendly reception**).

  ➞ Advanced setting in TEL priority mode
<table>
<thead>
<tr>
<th><strong>DRPD or Network switch</strong></th>
<th><strong>FAX only mode</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>When receiving voice calls (with a telephone or answering machine connected to the machine) and subscribing to a ring pattern detection service provided by your telephone company:</td>
<td>When not receiving voice calls:</td>
</tr>
<tr>
<td>When a call incomes, the telephone will ring. The machine detects a fax call by the fax ring pattern. If the call is a fax, the machine will receive the fax automatically. If the machine does not detect the fax ring pattern, the telephone will continue ringing.</td>
<td>When a fax incomes, the machine will receive the fax automatically.</td>
</tr>
</tbody>
</table>

**Note**
- You can select the ring pattern assigned to the fax number (for DRPD) and change the number of times to ring the telephone.
  - Advanced setting in **DRPD**
  - Advanced setting in **Network switch**
- The telephone may not ring when a call incomes even if it is connected to the machine, depending on the type or settings of the telephone.

**Note**
- You can change the number of times to ring the telephone (for Incoming ring).
  - Advanced setting in **FAX only mode**
Setting the Sender Information

You can set the sender information such as date/time, unit name, and unit fax/telephone number.

- About the Sender Information
- Setting the Date and Time
- Setting Daylight Saving Time (Summer Time)
- Registering User Information

About the Sender Information

If the unit name and unit fax/telephone number are registered, they are printed with date and time as sender information on the recipient's fax.

A. Date and time of transmission
B. Unit fax/telephone number
C. Unit name
D. The registered recipient's name is printed when sending faxes with the coded speed dial.
E. Page number

Note

- You can print USER'S DATA LIST to confirm the sender information you have registered.
- Summary of Reports and Lists
- When sending faxes in black & white, you can select whether to print the sender information inside or outside the image area.
- Specify the setting on TTI position in Advanced FAX settings under FAX settings.
- Advanced FAX settings
- You can select the date print format from three formats: YYYY/MM/DD, MM/DD/YYYY, and DD/MM/YYYY.
- Select the date print format on Date display format under Device user settings.
- Device user settings

Setting the Date and Time

This section describes the procedure to set the date and time.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the MENU button.
   - The menu screen is displayed.
3. Select **Setup**, then press the **OK** button.

4. Select **Device settings**, then press the **OK** button.

5. Use the ▲▼ button to select **Device user settings**, then press the **OK** button.

6. Use the ▲▼ button to select **Date/time setting**, then press the **OK** button.

7. Set the date and time.
   - Use the ◢◣ button to move the cursor under the desired position, then use the ▲▼ button to enter the date and time.
   
   ![](image)
   
   Enter the date and time in 24-hour format.
   Enter only the last two digits of the year.

8. Press the **OK** button.

9. Press the **FAX** button to return to the Fax standby screen.

**Setting Daylight Saving Time (Summer Time)**

Some countries adopt the daylight saving time (summer time) system that shifts the clock time forward at certain periods of the year.
You can set your machine to automatically change the time by registering the date and time that daylight saving time (summer time) begins and ends.

---

**Important**

- Not all the latest information of all countries or regions is applied for **Summer time setting** by default.
  You need to change the default setting according to the latest information of your country or region.

---

**Note**

- This setting may not be available depending on the country or region of purchase.

---

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the **MENU** button.
   - The menu screen is displayed.

3. Select **Setup**, then press the **OK** button.
4. Select **Device settings**, then press the **OK** button.

5. Use the ▲▼ button to select **Device user settings**, then press the **OK** button.

6. Use the ▲▼ button to select **Summer time setting**, then press the **OK** button.

7. Use the ▲▼ button to select **ON**, then press the **OK** button.
   To disable summer time, select **OFF**.

8. Set the date and time when summer time starts.
   1. Set the date when summer time starts.
      Use the ▲▼ button to change the setting item, use the ◀▶ button to change the setting, then use the **OK** button to confirm the selection.
      ![Start date/time](image1)

   2. Set the time (in 24-hour format) when summer time starts.
      Use the ◀▶ button to move the cursor under the desired position, use the ▲▼ button to enter the time, then press the **OK** button.
      Precede single digits with a zero.
      ![Start date/time](image2)

9. Set the date and time when summer time ends.
   1. Set the date when summer time ends.
      Use the ▲▼ button to change the setting item, use the ◀▶ button to change the setting, then use the **OK** button to confirm the selection.
      ![End date/time](image3)

   2. Set the time (in 24-hour format) when summer time ends.
Use the button to move the cursor under the desired position, use the button to enter the time, then press the OK button. Precede single digits with a zero.

10. Press the FAX button to return to the Fax standby screen.

Registering User Information

This section describes the procedure to register the user information.

**Note**
Before sending a fax, be sure to enter your name and fax/telephone number in Unit name and Unit TEL on the User information settings screen (for US only).

1. Make sure that the machine is turned on.
   ➩ Confirming that the Power Is On

2. Press the MENU button.
   The menu screen is displayed.

3. Select Setup, then press the OK button.

4. Select Device settings, then press the OK button.

5. Use the button to select FAX settings, then press the OK button.

6. Use the button to select FAX user settings, then press the OK button.

7. Use the button to select User information settings, then press the OK button.
   The screen to register the unit name and the unit fax/telephone number is displayed.

8. Enter the unit name.
1. Use the ▲▼ button to move the cursor to **Unit name**.
2. Press the OK button.
   The screen to enter the character is displayed.
3. Enter the unit name.

4. Press the left Function button.

   **Note**
   - You can enter the name up to 24 characters, including spaces.
   - For details on how to enter or delete characters:
     - Entering Numbers, Letters, and Symbols

9. Enter the unit fax/telephone number.
   1. Use the ▲▼ button to move the cursor to **Unit TEL**.
   2. Press the OK button.
      The screen to enter the number is displayed.
   3. Enter the unit fax/telephone number.

4. Press the left Function button.

   **Note**
   - You can enter the fax/telephone number up to 20 digits, including spaces.
   - For details on how to enter or delete characters:
     - Entering Numbers, Letters, and Symbols

10. Press the left Function button to finalize registration.

11. Press the **FAX** button to return to the Fax standby screen.
Sending Faxes Using the Operation Panel of the Machine

- Sending Faxes with the Numeric Buttons
- Resending Faxes (Redialing a Busy Number)
- Sending Faxes Using Useful Functions
Sending Faxes with the Numeric Buttons

This section describes dialing and sending faxes directly using the Numeric buttons.

**Important**

- It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them after speaking on the telephone.

**Sending a Fax after Speaking on Telephone**

1. Make sure that the machine is turned on.

   **Confirming that the Power Is On**

2. Press the FAX button.

   The Fax standby screen is displayed.

   ![Fax Standby Screen](image)

   **Note**

   - If you have not set up the machine for sending/receiving faxes yet, the message for setup is displayed on the LCD when you press the FAX button for the first time. When you set up for faxing, follow the procedure according to the instructions on the LCD.

3. Load documents on the platen glass or in the ADF.

   **Loading Originals**

   **Important**

   - When sending a double-sided document, load the document on the platen glass. Double-sided documents cannot be automatically scanned and sent from the ADF.

   **Note**

   - For details on the types, conditions of document, and how to load the document:

   **Loading Originals**

4. Adjust the scan contrast and resolution as necessary.

   Adjust the scan contrast and resolution following the procedure below.

   1. Press the right Function button.

      The TX image quality settings screen is displayed.
2. Use the ▲▼ button to change the setting item and use the ◀▶ button to change the setting.

The following settings are selectable on **ScanRes..**

- **Standard**
  Suitable for text-only documents.

- **Fine**
  Suitable for fine-print documents.

- **Extra fine**
  Suitable for detailed illustration or fine-print quality documents.
  If the recipient's fax machine is not compatible with **Extra fine** (300 x 300 dpi), the fax will be sent in the **Standard** or **Fine** resolution.

- **Photo**
  Suitable for photographs.

**Note**

- When sending a color fax, documents are always scanned in the same resolution (200 x 200 dpi). The image quality (compression rate) is determined by which scan resolution is selected, except that **Extra fine** and **Photo** provide the same image quality.

3. Press the **OK** button.
   The LCD returns to the Fax standby screen.

5. Use the Numeric buttons to dial the recipient's fax/telephone number.

Use the following buttons to dial the recipient's fax/telephone number.

- **Numeric buttons:**
  Enters the number.

- **Right Function button:**
  Enters a space.

- **Center Function button:**
  Deletes the last character you entered.

- **Left Function button:**
  By pressing this button, you can add recipients registered to the coded speed dial.
  
  ➤ **Sending the Same Document to Several Recipients (Sequential Broadcasting)**
6. Press the **Color** button for color transmission, or the **Black** button for black & white transmission.

The machine starts scanning the document.

**Important**
- Color transmission is available only when the recipient's fax machine supports color faxing.
- Do not open the document cover until scanning is completed.

7. Start sending.

- **If you load the document in the ADF:**
  The machine scans the document automatically and starts sending the fax.

  **Note**
  - To cancel a fax transmission, press the **Stop** button. To cancel a fax transmission while it is in progress, press the **Stop** button, then follow the instructions on the LCD.
  - If documents remain in the ADF after the **Stop** button is pressed while scanning is in progress, **Document in ADF. Select OK to eject document.** is displayed on the LCD. By pressing the **OK** button, the remaining documents are automatically ejected.

- **If you load the document on the platen glass:**
  The **Placing documents (platen)** screen appears on the LCD after scanning each sheet of document.
  To send the scanned document, press the **OK** button to start sending it.

  **Note**
  - To send two or more pages, follow the message to load the next page, and press the **Color** or **Black** button. After scanning all pages, press the **OK** button to start sending.
  - To cancel sending the fax, press the **Stop** button.

**Note**
- When your machine is connected to a PBX (Private Branch Exchange) system, refer to the operating instructions of the system for details on dialing the recipient's fax/telephone number.
- In case the machine was not able to send a fax, such as when the recipient's line was busy, it has the function to automatically redial the number after a specified interval. Automatic redialing is enabled by default.
- **Automatic Redialing**
- Unsent documents, such as those pending redial, are stored in the machine's memory. They are not stored in the case of a sending error.
- **Document Stored in Machine's Memory**
- Do not disconnect the power plug until all documents are sent. If you disconnect the power plug, all unsent documents stored in the machine's memory are lost.
Resending Faxes (Redialing a Busy Number)

There are two methods of redialing: Automatic redialing and Manual redialing.

- **Automatic Redialing**
  - If you send a document and the recipient's line is busy, the machine will redial the number after a specified interval.
  > Automatic Redialing

- **Manual Redialing**
  - You can redial to the recipients dialed using the Numeric buttons.
  > Manual Redialing

### Important
- It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them after speaking on the telephone.
  > Sending a Fax after Speaking on Telephone

### Note
- Automatic redialing is enabled by default.
- For details on the basic sending operations: Sending Faxes with the Numeric Buttons

---

## Automatic Redialing

You can enable or disable automatic redialing. If you enable automatic redialing, you can specify the maximum number of redial attempts and the length of time the machine waits between redial attempts.

Enable and specify the automatic redialing setting on Auto redial in Advanced FAX settings under FAX settings.

> Advanced FAX settings

### Important
- While automatic redialing, the unsent fax is stored in the machine's memory temporarily until the sending fax is complete. If a power failure occurs or you unplug the power cord before automatic redialing is complete, all faxes stored in the machine's memory are deleted and not sent.

### Note
- To cancel automatic redialing, wait until the machine starts redialing, then press the Stop button.
- To cancel automatic redialing, delete the unsent fax from the machine's memory while the machine is on-standby for a redial operation. For details, see Deleting a Document in Machine's Memory.

---

## Manual Redialing

Follow the procedure below for manual redialing.

1. Make sure that the machine is turned on.
   > Confirming that the Power Is On

2. Press the FAX button.
   - The Fax standby screen is displayed.

3. Load documents on the platen glass or in the ADF.
   > Loading Originals

4. Adjust the scan contrast and resolution as necessary.

> Note
5. Press the **Redial/Pause** button.

The **Redial** screen is displayed.

![Redial Screen]

6. Use the **▲▼** button to select the recipient's number to redial, then press the **OK** button.

7. Press the **Color** button for color transmission, or the **Black** button for black & white transmission.

<table>
<thead>
<tr>
<th>Important</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color transmission is available only when the recipient's fax machine supports color faxing.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>For manual redialing, the machine memorizes up to 10 recent recipients dialed using the Numeric buttons. Note that the machine does not memorize any recipients dialed using the <strong>Coded Dial</strong> or <strong>Redial/Pause</strong> button.</td>
</tr>
<tr>
<td>To cancel manual redialing, press the <strong>Stop</strong> button. To cancel a fax transmission while it is in progress, press the <strong>Stop</strong> button, then follow the instructions on the LCD.</td>
</tr>
<tr>
<td>If documents remain in the ADF after the <strong>Stop</strong> button is pressed while scanning is in progress, <strong>Document in ADF. Select OK to eject document.</strong> is displayed on the LCD. By pressing the <strong>OK</strong> button, the remaining documents are automatically ejected.</td>
</tr>
</tbody>
</table>
Sending Faxes Using Useful Functions

- Sending a Fax after Speaking on Telephone
- Sending a Fax Using the Speed Dialing Feature
- Searching a Registered Recipient by Name
- Sending the Same Document to Several Recipients (Sequential Broadcasting)
- Preventing Mistransmission of Faxes
- Using the On Hook Dial Function
Sending a Fax after Speaking on Telephone

If you want to speak to the recipient before sending a fax, or if the recipient does not have a fax machine that can receive faxes automatically, send a fax manually after speaking to the recipient on the telephone to check whether the recipient can receive faxes.

Important

- It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them after speaking on the telephone. See below for the procedure to send a fax manually.
- With manual transmission, you cannot use the platen glass to load documents. Load the documents in the ADF.
  When loading document on the platen glass, send a fax with automatic transmission.
- To speak to the recipient before sending a fax, you need to connect a telephone to the machine.
  For details on how to connect the telephone to the machine:
  ➤ Basic Connection

Note

For details on how to send a fax manually:

1. Make sure that the machine is turned on.
  ➤ Confirming that the Power Is On

2. Press the FAX button.
  The Fax standby screen is displayed.

3. Load documents in the ADF.
  ➤ Loading Originals

4. Adjust the scan contrast and resolution as necessary.

Note

- For details on how to adjust the scan contrast and resolution, see Sending Faxes with the Numeric Buttons.

5. Lift the handset of the telephone connected to the machine.

6. Use the telephone to dial the recipient's fax/telephone number.

7. Speak to the recipient.
  When you hear a high-pitched signal instead of the recipient's voice, you cannot check whether the recipient can receive faxes. If you want to stop sending the fax, replace the handset. If you want to send the fax, go to step 9.

8. Ask the recipient to set the recipient's fax machine to receive faxes.

9. When you hear a high-pitched signal, press the Color button or the Black button.
  Press the Color button for color transmission, or the Black button for black & white transmission.

Important

- Color transmission is available only when the recipient's fax machine supports color faxing.
10. Hang up the handset.

**Note**

- To cancel a fax transmission, press the **Stop** button. To cancel a fax transmission while it is in progress, press the **Stop** button, then follow the instructions on the LCD.
- If documents remain in the ADF after the **Stop** button is pressed while scanning is in progress, **Document in ADF. Select **OK** to eject document.** is displayed on the LCD. By pressing the **OK** button, the remaining documents are automatically ejected.
Sending a Fax Using the Speed Dialing Feature

Registering recipient's fax/telephone number and name for coded speed dial or group dial enables you to send faxes easily.

**Important**

- It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them after speaking on the telephone.

**Note**

- For details on the basic sending operations:
  - Sending Faxes with the Numeric Buttons

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the **FAX** button.
   - The Fax standby screen is displayed.

3. Load documents on the platen glass or in the ADF.
   - Loading Originals

4. Adjust the scan contrast and resolution as necessary.
   
   **Note**
   
   - For details on how to adjust the scan contrast and resolution, see Sending Faxes with the Numeric Buttons.

5. Press the **Coded Dial** button.
   - The screen to select a coded speed dial code or a group dial code is displayed.

   **Note**
   
   - When **Enter first letter** is displayed on the LCD, you can search the recipient's name by sorting in alphabetical order and send the fax.
   - Searching a Registered Recipient by Name
   
   To return to the screen to select the coded speed dial code or the group dial code, press the left **Function** button.

6. Select a coded speed dial code or a group dial code.

   1. Use the ▲▼ button or the Numeric buttons to select a coded speed dial code or a group dial code.
2. Press the **OK** button.

7. Press the **Color** button for color transmission, or the **Black** button for black & white transmission.

<table>
<thead>
<tr>
<th>Important</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color transmission is available only when the recipient's fax machine supports color faxing.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
</table>
| To cancel a fax transmission, press the **Stop** button. To cancel a fax transmission while it is in progress, press the **Stop** button, then follow the instructions on the LCD.  
| If documents remain in the ADF after the **Stop** button is pressed while scanning is in progress, **Document in ADF. Select OK to eject document.** is displayed on the LCD. By pressing the **OK** button, the remaining documents are automatically ejected.  
| In case the machine was not able to send a fax, such as when the recipient's line was busy, it has the function to automatically redial the number after a specified interval. Automatic redialing is enabled by default.  
| **Automatic Redialing**  
| To cancel automatic redialing, wait until the machine starts redialing, then press the **Stop** button. |
Searching a Registered Recipient by Name

You can search a registered recipient by sorting in alphabetical order and send the fax.

Important
- It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them after speaking on the telephone.
  ➤ Sending a Fax after Speaking on Telephone

Note
- For details on the basic sending operations:
  ➤ Sending Faxes with the Numeric Buttons

1. Make sure that the machine is turned on.
  ➤ Confirming that the Power Is On

2. Press the FAX button.
The Fax standby screen is displayed.

3. Load documents on the platen glass or in the ADF.
  ➤ Loading Originals

4. Adjust the scan contrast and resolution as necessary.
  ➤ Note
  - For details on how to adjust the scan contrast and resolution, see Sending Faxes with the Numeric Buttons.

5. Press the Coded Dial button.
The screen to select a coded speed dial code or a group dial code is displayed.

       Coded speed dial

     00 L. George
     01 Alice
     02 D. V. Michael
     03 Friend 1

     OK Set
     Search tel no.

  ➤ Note
  - If Enter first letter is displayed on the LCD, go to step 7.

6. Press the left Function button.
The screen to enter the first letter of the registered recipient's name or of the group name is displayed.
7. Use the Numeric buttons to enter the first letter of the recipient's name you want to search or of the group name you want to search.

The recipients' names and the group names are sorted in alphabetical order.

8. Use the ▲▼ button to select the recipient's name or the group name, then press the OK button.

9. Press the Color button for color transmission, or the Black button for black & white transmission.

**Important**

- Color transmission is available only when the recipient's fax machine supports color faxing.

**Note**

- To return to the screen to select the coded speed dial code or the group dial code, press the left Function button.

- For details on how to enter or delete characters:
  - Entering Numbers, Letters, and Symbols
  - You can enter the following characters using the Numeric buttons:
    A, D, G, J, M, P, T, W
  - If the entered character does not match the first character of any of the recipients' name or the group name, names beginning with the character closest to that entered are displayed.

- To cancel a fax transmission, press the Stop button. To cancel a fax transmission while it is in progress, press the Stop button, then follow the instructions on the LCD.
- If documents remain in the ADF after the Stop button is pressed while scanning is in progress, **Document in ADF. Select OK to eject document** is displayed on the LCD. By pressing the OK button, the remaining documents are automatically ejected.
- In case the machine was not able to send a fax, such as when the recipient's line was busy, it has the function to automatically redial the number after a specified interval. Automatic redialing is enabled by default.
- **Automatic Redialing**
  To cancel automatic redialing, wait until the machine starts redialing, then press the Stop button.
Sending the Same Document to Several Recipients (Sequential Broadcasting)

This machine allows you to prepare for sending the same document to a maximum of 101 recipients in one operation. The recipients can be specified with the Numeric buttons, coded speed dial, and group dial in combination.

The following number of recipients can be specified in combination.

- The recipient registered to the machine:
  - Up to 100 (total of coded speed dial and group dial)
- Dialing using the Numeric buttons or redialing:
  - 1

**Important**

It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them one by one after speaking on the telephone.

**Note**

If you frequently send documents to the same group of recipients, you can group these numbers for group dialing. This will allow you to send documents to all the recipients in the group by simply pressing a few buttons.

- Registering Recipients for Group Dial
- For details on the basic sending operations:
  - Sending Faxes with the Numeric Buttons

---

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the FAX button.
   - The Fax standby screen is displayed.

3. Load documents on the platen glass or in the ADF.
   - Loading Originals

4. Adjust the scan contrast and resolution as necessary.
   - Note
     - For details on how to adjust the scan contrast and resolution, see Sending Faxes with the Numeric Buttons.

5. Specify all recipients’ fax/telephone numbers one by one.
   - Before finishing specifying all recipients’ fax/telephone numbers, do not press the Color button or the Black button.
     - By specifying with the recipient registered to the machine (coded speed dial or group dial):
       - Press the Coded Dial button, select a recipient, then press the OK button.
       - Sending a Fax Using the Speed Dialing Feature
       - Searching a Registered Recipient by Name
     - By dialing using the Numeric buttons:
       - Use the Numeric buttons to enter the recipient's fax/telephone number, then press the left Function button.
   - Note
     - If FAX number re-entry in Security control under FAX settings is set to ON, use the Numeric buttons again to enter the number.
• By redialing:
  Press the Redial/Pause button, use the ▲▼ button to select the number you want to dial, then press the OK button.

  The Sequential broadcasting screen is displayed after specifying the multiple recipients.

  ![Sequential broadcasting screen](image)

  **Note**
  - You can review the numbers you have entered by pressing the ▲▼ button on the Sequential broadcasting screen.
  - Pressing the Back button allows you to delete the recipient's number you entered last.

6. Press the Color button for color transmission, or the Black button for black & white transmission.

  **Important**
  - Color transmission is available only when the recipient's fax machine supports color faxing.

  **Note**
  - To cancel sequential broadcasting, press the Stop button. To cancel a fax transmission while it is in progress, press the Stop button, then follow the instructions on the LCD.
  - If documents remain in the ADF after the Stop button is pressed while scanning is in progress, Document in ADF. Select OK to eject document. is displayed on the LCD. By pressing the OK button, the remaining documents are automatically ejected.
  - When you press the Stop button, fax transmission to all the recipients specified will be canceled. You cannot cancel a fax transmission to only one recipient.
Preventing Mistransmission of Faxes

This machine has two functions for preventing the mistransmission of faxes.

- Sending faxes after entering the fax/telephone number twice
  This function requires you to re-enter the fax/telephone number after entering the number using the Numeric buttons, so that the machine prevents you from misdialing.
  ➤ Sending Faxes after Dialing Twice (Fax Number Re-entry)
- Sending faxes after the machine checks the recipient's fax machine information
  Before sending a fax, the machine checks whether the recipient's fax machine information matches the dialed number.
  ➤ Sending Faxes after Checking Information (Checking the Recipient's Information)

Sending Faxes after Dialing Twice (Fax Number Re-entry)

Set FAX number re-entry to ON following the procedure below.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Press the MENU button.
   The menu screen is displayed.

3. Select Setup, then press the OK button.

4. Select Device settings, then press the OK button.

5. Use the ▲▼ button to select FAX settings, then press the OK button.

6. Use the ▲▼ button to select Security control, then press the OK button.

7. Use the ▲▼ button to select FAX number re-entry, then press the OK button.

8. Use the ▲▼ button to select ON, then press the OK button.

If you send a fax with this function, the following screen is displayed after entering the recipient's fax/telephone number using the Numeric buttons.

Enter the recipient's fax/telephone number using the Numeric buttons again.

Note

If the number is not identical with the number entered first, the Fax standby screen is displayed.
Sending Faxes after Checking Information (Checking the Recipient's Information)

Set **Check RX FAX information** to **ON** following the procedure below.

**Important**

- This function is not available when you send a fax manually.
- **Sending a Fax after Speaking on Telephone**

1. Make sure that the machine is turned on.
   
   ➡️ Confirming that the Power Is On

2. Press the **MENU** button.
   
   The menu screen is displayed.

3. Select **Setup**, then press the **OK** button.

4. Select **Device settings**, then press the **OK** button.

5. Use the **▲▼** button to select **FAX settings**, then press the **OK** button.

6. Use the **▲▼** button to select **Security control**, then press the **OK** button.

7. Use the **▲▼** button to select **Check RX FAX information**, then press the **OK** button.

8. Use the **▲▼** button to select **ON**, then press the **OK** button.

**Important**

- Transmission will be canceled if the machine fails to receive the recipient's fax information or if the received information does not match the fax/telephone number.
Using the On Hook Dial Function

Follow the procedure below to send faxes with the on hook dial function.

**Important**
- It may be possible that faxes will reach unintended recipients due to the misdialing or incorrect registration of fax/telephone numbers. When you send important documents, it is recommended that you send them after speaking on the telephone.
- Sending a Fax after Speaking on Telephone
- With manual transmission, you cannot use the platen glass to load documents. Load the documents in the ADF. When loading document on the platen glass, send a fax with automatic transmission.

**Sending Faxes with the Numeric Buttons**

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can use the <strong>Hook</strong> button only when <strong>Hook key setting</strong> in <strong>Security control</strong> under <strong>FAX settings</strong> is set to <strong>Enable</strong>.</td>
</tr>
<tr>
<td>Security control</td>
</tr>
<tr>
<td>For details on the basic sending operations:</td>
</tr>
<tr>
<td>Sending Faxes with the Numeric Buttons</td>
</tr>
</tbody>
</table>

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the **FAX** button.
   - The Fax standby screen is displayed.

3. Load documents in the ADF.
   - Loading Originals

4. Adjust the scan contrast and resolution as necessary.
   - **Note**
     - For details on how to adjust the scan contrast and resolution, see Sending Faxes with the Numeric Buttons.

5. Press the **Hook** button.

6. Use the Numeric buttons to dial the recipient's fax/telephone number.
   - **Note**
     - You can also dial using speed dialing or manual redialing.

7. When you hear a high-pitched signal, press the **Color** button or the **Black** button.
   - Press the **Color** button for color transmission, or the **Black** button for black & white transmission.
   - **Important**
     - Color transmission is available only when the recipient's fax machine supports color faxing.
   - **Note**
     - To cancel a fax transmission, press the **Stop** button. To cancel a fax transmission while it is in progress, press the **Stop** button, then follow the instructions on the LCD.
If documents remain in the ADF after the Stop button is pressed while scanning is in progress, Document in ADF. Select OK to eject document. is displayed on the LCD. By pressing the OK button, the remaining documents are automatically ejected.
Registering Recipients

- Registering Recipients Using the Operation Panel of the Machine
- Registering Recipients Using Speed Dial Utility
Registering Recipients Using the Operation Panel of the Machine

Speed dialing allows you to dial fax/telephone numbers by simply pressing a few buttons. The following speed dialing methods are available:

- Coded Speed Dialing
  Registering the recipient's fax/telephone number and name to the coded speed dial allows you to send a fax by entering the coded speed dial code assigned to that number or using the ▲▼ button to select the coded speed dial code after pressing the Coded Dial button.
  ➤ Registering Recipients to Coded Speed Dial
- Group Dialing
  Register two or more registered coded speed dial codes as a group in advance. You can send the same document to all the registered recipients in the group.
  ➤ Registering Recipients for Group Dial

You can register up to 100 recipients in total of coded speed dial code and group dial code.

Note

- To change information registered to the coded speed dial or the group dial, see Changing Registered Information.
- To delete information registered to the coded speed dial or the group dial, see Deleting Registered Information.
- To print a list of the recipient's fax/telephone numbers and names registered, see Printing a List of the Registered Destinations.
- You can register, change, or delete information registered to the coded speed dial or the group dial using Speed Dial Utility.
  ➤ Registering Recipients Using Speed Dial Utility
Registering Recipients to Coded Speed Dial

Before you can use the coded speed dialing feature, you need to register the recipients’ fax/telephone numbers. Follow the procedure below to register the recipients’ fax/telephone numbers.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the left Function button.
   The Fax menu screen is displayed.

4. Select TEL number registration, then press the OK button.

5. Use the ▲▼ button to select Coded speed dial, then press the OK button.
   The screen to select a coded speed dial code is displayed.

   ![Coded speed dial screen]

   **Note**
   If you select a code already used as a coded speed dial, the fax/telephone number is displayed next to the code. If you select a code already used as a group dial, (Not available) is displayed.

6. Use the ▲▼◄► button to select an unoccupied coded speed dial code, then press the OK button.

7. Use the ▲▼ button to select a registration method, then press the OK button.
   - Direct entry
     The screen to register the recipient’s fax/telephone number and name is displayed. Go to next step.
When you select this registration method, the screen to select the fax/telephone number from the outgoing call logs is displayed.

Using the ▲▼ button to select a fax/telephone number and pressing the OK button, the screen to register the recipient's fax/telephone number and name is displayed. Go to next step.

When you select this registration method, the screen to select the fax/telephone number or the name from the incoming call logs is displayed.

Using the ▲▼ button to select a fax/telephone number or name and pressing the OK button, the screen to register the recipient's fax/telephone number and name is displayed. Go to next step.

**Note**
- This registration method may not be available depending on the country or region of purchase.

8. Enter the recipient's name.

   If you select a name on From incoming call log in step 7, the name may be already entered. If you do not change the name, go to step 9.
   1. Use the ▲▼ button to move the cursor to **Name**.
   2. Press the OK button.
      - The screen to enter the character is displayed.
   3. Enter the recipient's name.
4. Press the left Function button.

**Note**

- You can enter the name up to 16 characters, including spaces.
- For details on how to enter or delete characters: Entering Numbers, Letters, and Symbols

9. Enter the recipient's fax/telephone number.

If you select a fax/telephone number on From outgoing call log or From incoming call log, the fax/telephone number is already entered. If you do not change the fax/telephone number, go to next step.

1. Use the ▲▼ button to move the cursor to TEL no.
2. Press the OK button.
   The screen to enter the number is displayed.
3. Enter the recipient's fax/telephone number.
4. Press the left Function button.

**Note**

- You can enter the fax/telephone number up to 60 digits (40 digits for the US, Canada, Korea and some regions of Latin America), including spaces.
- For details on how to enter or delete characters: Entering Numbers, Letters, and Symbols
- When Telephone line type in FAX user settings under FAX settings is set to Rotary pulse, you can enter a tone (“T”) by pressing the Tone button.

10. Press the left Function button to finalize registration.

**Note**

- To register another recipient's number and name to a coded memory dial, select an unoccupied coded memory dial code and operate in the same procedure when you register.
- You can check the recipient's numbers and names you have registered by printing CODED SPEED DIAL TELEPHONE NO. LIST.
  ->Printing a List of the Registered Destinations
Registering Recipients for Group Dial

If you register two or more registered coded speed dial codes to a group dial, you can send the same document successively to all recipients registered to the group dial.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the left Function button.
   The Fax menu screen is displayed.

4. Select TEL number registration, then press the OK button.

5. Use the ▲▼ button to select Group dial, then press the OK button.
   The screen to select a group dial code is displayed.

6. Use the ▲▼◀▶ button to select an unoccupied coded speed dial code, then press the OK button.
   The screen to register the group name and the member of the group is displayed.

7. Enter the group name.
   1. Ensure that Group name is displayed.
2. Press the **OK** button.
The screen to enter the character is displayed.

3. Enter the group name.

4. Press the left **Function** button.

   **Note**
   - You can enter the name up to 16 characters, including spaces.
   - For details on how to enter or delete characters:
     - Entering Numbers, Letters, and Symbols

8. Register the members.
   1. Ensure that **Member** is displayed.

2. Press the left **Function** button or the **Coded Dial** button.
The screen to select a coded speed dial code is displayed.
3. Use the ▲▼ button or the Numeric buttons to select a coded speed dial code to register to the group dial.

![Coded speed dial menu](image)

**Note**
- When **Enter first letter** is displayed on the LCD, you can search the recipient's name by sorting in alphabetical order.
- Use the Numeric buttons to enter the first letter of the recipient's name you want to search, use the ▲▼ button to select a coded speed dial code to register to the group dial, then press the **OK** button.
- **Searching a Registered Recipient by Name**
  - To return to the screen to select the coded speed dial code or the group dial code, press the left **Function** button.

4. Press the **OK** button.
   - The coded speed dial code is registered to the group dial.

![Registered recipient screen](image)

5. Press the left **Function** button or the **Coded Dial** button to display the screen to select a coded speed dial code, then add another member.
   - Repeat this step to register the other coded speed dial codes to the same group dial.

**Note**
- You can check the coded speed dial code and the recipient's name registered to the group dial by using the ▲▼ button.
- To delete the member, use the ▲▼ button to select a coded speed dial code of the member that you want to delete, then press the right **Function** button.

9. Press the **OK** button to finalize registration.

**Note**
- To register another group, select an unoccupied coded memory dial code and operate in the same procedure when you register.
- You can check the recipients you have registered to the group dial by printing GROUP DIAL TELEPHONE NO. LIST.
  - **Printing a List of the Registered Destinations**
Changing Registered Information

To change information registered for coded speed dial and group dial, follow the procedure below.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the left Function button.
   The Fax menu screen is displayed.

4. Select TEL number registration, then press the OK button.

5. Use the ▲▼ button to select a registration menu to change, then press the OK button.

6. Use the ▲▼◄► button to select a coded speed dial code or group dial code to change, then press the OK button.

7. Use the ▲▼ button to select Edit, then press the OK button.
   • To change a coded speed dial code:
     The screen to change the recipient's name and the fax/telephone number is displayed.
   • To change a coded speed dial code registered to a group dial code:
     The screen to change the group name and the member is displayed.

8. Change the registered information.
   • To change a coded speed dial code:
     When you want to change the recipient's name, move the cursor to Name then change the recipient's name. After pressing the OK button, the cursor moves to TEL no.. To register the changed recipient's name, press the OK button again.
     When you want to change the fax/telephone number, move the cursor to TEL no. then change the fax/telephone number. After pressing the OK button, the changed number is registered.
   • To change a group dial code:
     When you want to change the group name, move the cursor to Group name then change the group name. After pressing the OK button, the cursor moves to Member. To register the changed group name, press the OK button again.
     When you want to add the member to group or delete from group, move the cursor to Member then add the member or delete. After pressing the OK button, the changed group is registered.
Deleting Registered Information

To delete information registered for coded speed dial and group dial, follow the procedure below.

1. Make sure that the machine is turned on.
   ➤ Confiming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the left Function button.
   The Fax menu screen is displayed.

4. Select TEL number registration, then press the OK button.

5. Use the ▲▼ button to select a registration menu to delete, then press the OK button.

6. Use the ▲▼◄► button to select a coded speed dial code or group dial code to delete, then press the OK button.

7. Use the ▲▼ button to select Delete, then press the OK button.

8. Use the ▲▼ button to select Yes, then press the OK button.
Printing a List of the Registered Destinations

You can print a list of the recipients registered for speed dialing and can keep it near the machine to refer to when dialing.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Load paper.
   - Loading Paper

3. Press the FAX button.
   The Fax standby screen is displayed.

4. Press the left Function button.
   The Fax menu screen is displayed.

5. Select Print reports/lists, then press the OK button.

6. Use the ▲▼ button to select Telephone number list, then press the OK button.

7. Use the ▲▼ button to select a speed dialing menu to print, then press the OK button.

   - If you selected Coded speed dial:
     Use the ▲▼ button to select whether to print the list in alphabetical order of the registered names, or in numerical order of the coded speed dial codes, then press the OK button.
     Yes: Prints CODED SPEED DIAL TELEPHONE NO. LIST with the destination names in alphabetical order.
     No: Prints CODED SPEED DIAL TELEPHONE NO. LIST with the registered entries in numerical order.

   - If you selected Group dial:
     The printing confirmation screen is displayed. Select Yes using the ▲▼ button and press the OK button to print GROUP DIAL TELEPHONE NO. LIST.
Registering Recipients Using Speed Dial Utility

About Speed Dial Utility

Speed Dial Utility is a utility for forwarding the fax/telephone numbers registered on the machine to a computer and registering/changing them on the computer. In addition, you can register the fax/telephone number, user's name, user's fax/telephone number, and rejected numbers edited on the computer to the machine. You can also save them on the computer as a backup.

For safety reasons, it is recommended that you backup the registered data on the computer using Speed Dial Utility.

- Starting Up Speed Dial Utility
- Speed Dial Utility Dialog box
- Saving Registered Information on the Machine to Your Computer
- Registering a Fax/telephone Number Using Speed Dial Utility
- Changing a Fax/telephone Number Using Speed Dial Utility
- Deleting a Fax/telephone Number Using Speed Dial Utility
- Changing Sender Information Using Speed Dial Utility
- Registering/Changing Rejected Number Using Speed Dial Utility
- Calling the Registered Information Up from Your Computer and Registering the Information to the Machine
- Uninstalling Speed Dial Utility
Starting Up Speed Dial Utility

Before starting up Speed Dial Utility, confirm the following:

• **The necessary application software (MP Drivers and Speed Dial Utility) is installed.**
  
  If the application software (MP Drivers and Speed Dial Utility) is not yet installed, insert the Setup CD-ROM into the computer's disc drive, then install MP Drivers and Speed Dial Utility.

• **The machine is connected to a computer correctly.**
  
  Make sure that the machine is connected to the computer correctly.
  Do not plug in or unplug any cables while the machine is in operation, or when the computer is in sleep or standby mode.
  If your machine is compatible with LAN connection, make sure that the machine is connected to the computer with LAN connection to use Speed Dial Utility via LAN connection.

Follow the procedure below to start up Speed Dial Utility.

1. Make sure that the machine is turned on.

2. Click **Start** and select **All programs, Canon Utilities, Speed Dial Utility**, and then **Speed Dial Utility**.
   
   Speed Dial Utility starts up.

**Note**

You can also start up the Speed Dial Utility by clicking **Speed Dial Settings** from **Device Settings & Maintenance** on Quick Menu.
Speed Dial Utility Dialog box

The following items are on the Speed Dial Utility dialog box.

1. **Printer Name:**
   Selects the machine for editing the registered information using Speed Dial Utility.

2. **Display Printer Settings**
   Loads the registered information on the machine selected for Printer Name: into Speed Dial Utility.

3. **Setting Item List:**
   Selects the registered information for editing. Choose one item from TEL Number Registration, User Information Setting, and Rejected Number Setting.

4. **Registered information list**
   Displays the registered information selected for Setting Item List.

5. **Edit.../Select All/Delete**
   Edits/deletes the registered information or selects all the registered information selected for Setting Item List.
   When multiple items on the registered information list are selected, you cannot use the Edit... button.

6. **Load from PC...**
   Displays the registered information saved on the computer.

7. **Instructions**
   Displays this guide.
8. **Exit**
   Quits Speed Dial Utility. Information registered or edited using Speed Dial Utility is neither saved on the computer nor registered on the machine.

9. **Save to PC...**
   Saves information edited using Speed Dial Utility on the computer.

10. **Register to Printer**
    Registers information edited using Speed Dial Utility to the machine.
Saving Registered Information on the Machine to Your Computer

Follow the procedure below to save the speed dial (or memory dial)/group dial numbers, user's name, fax/telephone number, or rejected numbers on the machine to the computer.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the **Printer Name:** list box, then click **Display Printer Settings.**

3. Click **Save to PC.**

4. Enter the file name on the displayed screen, then click **Save.**
Registering a Fax/telephone Number Using Speed Dial Utility

Follow the procedure below to register fax/telephone numbers.

**Note**
Before you register fax/telephone numbers using Speed Dial Utility, make sure that no fax operations are in progress.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the Printer Name: list box, then click Display Printer Settings.

3. Click TEL Number Registration from Setting Item List:.
   The list of registered fax/telephone numbers is displayed.

4. Select an unoccupied code from the list, then click Edit....
   The Individual or Group Selection dialog box is displayed.

5. Click Register individual TEL number or Register group dial, then click Next....
   • If Register individual TEL number is selected:

     ![Individual TEL Number Registration dialog box](image)
     1. Enter the name.
     2. Enter the fax/telephone number.

   • If Register group dial is selected:

     ![Group Dial Registration dialog box](image)
1. Enter the group name.
2. Select the code you want to add to the group dial, then click **Add >>**.

**Note**
- You can only enter numbers that have already been registered.

6. **Click OK.**

To continue registering fax/telephone numbers or a group dial, repeat steps 4 to 6.
- **To save the registered information on the computer:**
  1. Click **Save to PC...**
  2. Enter the file name on the displayed screen, then click **Save**.

- **To register the registered information to the machine:**
  1. Click **Register to Printer**.
  2. Confirm the message on the display, then click **OK**.

The information is registered to the machine.
Changing a Fax/telephone Number Using Speed Dial Utility

Follow the procedure below to change fax/telephone numbers.

Note

Before you change fax/telephone numbers using Speed Dial Utility, make sure that no fax operations are in progress.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the Printer Name: list box, then click Display Printer Settings.

3. Click TEL Number Registration from Setting Item List:
   The list of registered fax/telephone numbers is displayed.

4. Select a code to change from the list, then click Edit....
   • If an individual fax/telephone number is selected:
     1. Enter the new name.
     2. Enter the new fax/telephone number.
   • If a group dial is selected:
     1. Enter the new group name.
     2. Add or delete a member to/from the group dial.
To add a member:
Select the code to add to the group dial, then click **Add >>**.

To delete a member:
Select the code to delete from the group dial, then click **<< Delete**.

5. Click **OK**.

To continue changing fax/telephone numbers or group dials, repeat steps 4 and 5.

- To save the edited information on the computer:
  1. Click **Save to PC**.
  2. Enter the file name on the displayed screen, then click **Save**.

- To register the edited information to the machine:
  1. Click **Register to Printer**.
  2. Confirm the message on the display, then click **OK**.

The information is registered to the machine.
Deleting a Fax/telephone Number Using Speed Dial Utility

Follow the procedure below to delete fax/telephone numbers.

**Note**

Before you delete fax/telephone numbers using Speed Dial Utility, make sure that no fax operations are in progress.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the **Printer Name** list box, then click **Display Printer Settings**.

3. Click **TEL Number Registration** from **Setting Item List**.
   The list of registered fax/telephone numbers is displayed.

4. Select a code to delete from the list, then click **Delete**.
   The selected fax/telephone number is deleted.
   To continue deleting fax/telephone numbers, repeat step 4.

**Note**

To delete all fax/telephone numbers on the list, click **Select All**, then **Delete**.

- To save the edited information on the computer.
  1. Click **Save to PC**.
  2. Enter the file name on the displayed screen, then click **Save**.

- To register the edited information to the machine:
  1. Click **Register to Printer**.
  2. Confirm the message on the display, then click **OK**.
     The information is registered to the machine.
Changing Sender Information Using Speed Dial Utility

Follow the procedure below to change the user's name or fax/telephone number.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the Printer Name: list box, then click Display Printer Settings.

3. Click User Information Setting from Setting Item List:.
   The user's information is displayed.

4. Select an item to change, then click Edit:..
   The User Information dialog box is displayed.

5. Enter the new user's name on User Name and new fax/telephone number in TEL Number, then click OK.
   • To save the edited information on the computer:
     1. Click Save to PC:..
     2. Enter the file name on the displayed screen, then click Save.
   • To register the edited information to the machine:
     1. Click Register to Printer.
     2. Confirm the message on the display, then click OK.
        The information is registered to the machine.
Registering/Changing Rejected Number Using Speed Dial Utility

Follow the procedure below to register, change, or delete rejected numbers.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the Printer Name: list box, then click Display Printer Settings.

3. Click Rejected Number Setting from Setting Item List:
   The list of rejected numbers is displayed.
   • To register a rejected number:
     1. Select an unoccupied code from the list, then click Edit....
     2. Enter the fax/telephone number in the Rejected Number dialog box, then click OK.
   • To change a rejected number:
     1. Select a code to change from the list, then click Edit....
     2. Enter the fax/telephone number in the Rejected Number dialog box, then click OK.
   • To delete a rejected number:
     1. Select a code to delete from the list, then click Delete.
        The selected fax/telephone number is deleted.

➤ Note
   To delete all fax/telephone numbers on the list, click Select All, then Delete.
Calling the Registered Information Up from Your Computer and Registering the Information to the Machine

You can register the fax/telephone numbers, user's name, user's fax/telephone number, and rejected numbers saved on the computer to the machine.

1. Start up Speed Dial Utility.
   ➤ Starting Up Speed Dial Utility

2. Select the machine from the Printer Name: list box, then click Display Printer Settings.

3. Click Load from PC....

4. Select the RSD file (*.rsd) to register to the machine.

5. Click Open on the dialog box.

6. Click Register to Printer.
   The registered information on the computer is registered to the machine.
Uninstalling Speed Dial Utility

Follow the procedure below to uninstall Speed Dial Utility.

**Important**
- Log into a user account with administrator privilege.

1. Uninstall Speed Dial Utility.
   - In Windows 7 or Windows Vista:
     1. Click **Start** > **Control Panel** > **Programs** > **Programs and Features**.
     2. Select **Canon Speed Dial Utility** from the program list, then click **Uninstall**.
        - If the **User Account Control** screen appears, click **Continue**.
   - In Windows XP:
     1. Click **Start** > **Control Panel** > **Add or Remove Programs**.
     2. Select **Canon Speed Dial Utility** from the program list, then click **Remove**.

2. Click **Yes** when the confirmation message appears.

   When the message prompting you to restart your computer is displayed, click **OK** to restart your computer.

**Note**
- To reinstall Speed Dial Utility, uninstall Speed Dial Utility, then install it again with the Setup CD-ROM.
Receiving Faxes

- Receiving Faxes
- Changing the Paper Settings
- Advanced Settings of Receive Mode
- Memory Reception
- Receiving Faxes Using Useful Functions
Receiving Faxes

This section describes the preparation necessary for receiving a fax and how to receive a fax.

Preparing for Receiving a Fax

Prepare for receiving a fax according to the following procedure.

1. Make sure that the machine is turned on.
   ➔ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Make sure of the receive mode setting.
   Make sure of the receive mode setting displayed on the Fax standby screen.

   ![Fax standby screen]

   ➔ Note
   For details on how to change the receive mode:
   ➔ Setting the Receive Mode

4. Load paper.
   Load the sheets of plain paper.
   ➔ Loading Paper

5. Specify the paper settings as necessary.
   ➔ Changing the Paper Settings
   This completes the preparation for receiving fax.
   When a fax is received, it is printed on the loaded paper automatically.

Receiving a Fax

Depending on the selected receive mode, the receive operation varies.

➤ Note
   For details on the receive mode:
   ➔ Setting the Receive Mode
   You can specify the advanced settings of each receive mode by displaying the Advanced screen.
   For details on the advanced settings of the receive mode:
   ➔ Advanced Settings of Receive Mode
   If the machine was not able to print a received fax, the machine stores the unprinted fax temporarily in its memory (memory receiving).
   ➔ Memory Reception
   You can save received faxes on a USB flash drive as PDF files automatically when receiving a fax.
   ➔ Saving Received Faxes Automatically on a USB Flash Drive
When TEL priority mode is selected:

When the call is a fax:

The telephone will ring when a call incomes.

Pick up the handset. If you hear the fax tone, wait for at least 5 seconds after it stops, then hang up the handset.

The machine will receive the fax.

**Note**

- If the machine will not switch to fax reception, press the FAX button, then the **Color** or **Black** button to receive the fax.
- To receive a fax without picking up the handset, set **Manual/auto switch** in **Advanced** to **ON**. **RX start time** allows you to specify the number of seconds until the machine switches to fax reception.
- If you have subscribed to Duplex Ringing service in Hong Kong, the telephone will ring a specified number of times when there is an incoming call with a fax distinctive ring pattern. Then, the machine will switch to fax reception automatically without the handset being picked up.
- The number of times to ring the telephone until switching to fax reception can be changed.
- Set the machine to enable you to initiate fax reception from a connected telephone (remote reception).

**Remote Reception**

**Note**

- When the answering machine is connected to the machine:
  - If the answering machine is set to the answering mode, set **User-friendly reception** in **Advanced** to **ON**. If the call is a fax, the machine will receive the fax automatically.
  - If the answering mode is turned off on the answering machine, pick up the handset. If you hear the fax tone, wait for at least 5 seconds after it stops, then hang up the handset.
  - If **Manual/auto switch** in **Advanced** is set to **ON**, set **RX start time** to longer than the time before the answering machine starts playing the answering message. After making this setting, we recommend that you call the answering machine using a mobile phone, etc. to confirm that messages are recorded successfully in the answering machine.
  - Set your answering machine to answering mode and adjust it as follows:
    - The entire message should be no longer than 15 seconds.
    - In the message, tell your callers how to send a fax.

When the call is a voice call:
The telephone will ring when a call incomes.

Pick up the handset, and talk on the telephone.

**Note**
- If the machine unexpectedly switches to fax reception during telephone calls, set **User-friendly reception** in **Advanced** to **OFF**.
- If **Manual/auto switch** in **Advanced** is set to **ON**, you must answer an incoming call by picking up the handset within the time specified in **RX start time**. Otherwise, the machine will switch to fax reception.

• When FAX only mode is selected:
  When the call is a fax:

  The machine will receive the fax automatically.

  **Note**
  - If a telephone is connected to the machine, the telephone will ring when a call incomes.
  - You can change the number of times to ring the telephone with **Incoming ring** in **Advanced**.

• When DRPD or Network switch is selected:
  When the call is a fax:

  The telephone will ring when a call incomes.

  The machine will receive the fax automatically when the fax ring pattern is detected.

  **Note**
  - You can change the number of times to ring the telephone.
  - **Advanced Settings of Receive Mode**

When the call is a voice call:

The telephone will ring when a call incomes.

When the machine does not detect the fax ring pattern, the telephone will continue ringing.
Pick up the handset, and talk on the telephone.

**Note**
- To use this feature, you need to subscribe to a compatible service provided by your telephone company.
- **For DRPD**
  You need to select the appropriate ring pattern on the machine.
  - Setting the DRPD Ring Pattern (US and Canada only)
- **For Network switch**
  The name of this service varies depending on the country or region of purchase. This setting may not be also available depending on the country or region of purchase.
Changing the Paper Settings

This machine prints received faxes to paper loaded in the machine beforehand. You can use the operation panel to change the paper settings for printing faxes. Make sure that the settings are appropriate for the loaded paper.

**Important**

- If the size of loaded paper is different from that specified in the paper size setting, the received faxes are stored in the machine's memory and **FAX output error Check the page size and select OK** is displayed on the LCD. In this case, load the same size of paper as that specified in the paper size setting, then press the **OK** button.
- You can also press the **Stop** button to close the message and print the stored documents in the machine's memory later.

**Note**

- If the sender sends a document that is larger than Letter-size or Legal-size, such as 11 x 17 inches, the sender's machine may send the fax automatically reduced in size or divided, or send only a part of the original.

1. Make sure that the machine is turned on.

   **Confirming that the Power Is On**

2. Press the **FAX** button.

   The Fax standby screen is displayed.

3. Press the left **Function** button.

   The Fax menu screen is displayed.

4. Select **FAX paper settings**, then press the **OK** button.

   The **FAX paper settings** screen is displayed.

5. Specify the settings.

   Use the **▼** button to change the setting item and use the **►** button to change the setting.

   ![FAX paper settings](image)

1. **Page size**

   Select the page size from **A4**, **Letter**, or **Legal**.
2. **Type**
   The paper type is set to **Plain paper**.

3. **2-sidedPrintSetting**
   Select two-sided printing or single-sided printing.
   Two sided printing is available for black & white faxes. Color faxes are printed on the single-side of paper regardless of this setting.
   After **2-sided** is selected for **2-sidedPrintSetting**, press the right **Function** button to specify the stapling side.

   **Note**
   - When **Page size** is set to **A4** or **Letter**, the received faxes are printed on the two-sides of paper.

6. Press the **OK** button.
   The LCD returns to the Fax menu screen.
Advanced Settings of Receive Mode

You can specify the advanced settings of each receive mode. This section describes the procedure to specify the advanced settings of the receive mode and the setting items. Specify the advanced settings following the procedure below.

1. Make sure that the machine is turned on.
   ➜ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the center Function button.
   The Receive mode settings screen is displayed.

4. Use the ▲▼ button to select a receive mode, then press the right Function button.

5. Use the ▲▼ button to select a setting item, then press the OK button.

6. Use the ▲▼ button to specify the setting, then press the OK button.
   Depending on the setting items, the related setting items are displayed after you specify the setting of the advanced settings and press the OK button. Use the ▲▼ button again to specify the setting, then press the OK button.

For details on advanced settings of each receive mode, see below.

➔ Advanced setting in TEL priority mode
➔ Advanced setting in FAX only mode
➔ Advanced setting in DRPD
➔ Advanced setting in Network switch

Note

- Refer to Receiving Faxes for information on receiving faxes or the procedure for each receive mode.
- DRPD is available only in the US and Canada.
- Network switch may not be available depending on the country or region of purchase.

Advanced setting in TEL priority mode

You can specify the following setting items.

- Manual/auto switch
  If you select ON, the machine automatically receives faxes after the external device rang a specified length of time.
  You can specify the length of time until automatic reception is started.
- User-friendly reception
  If you select ON, the machine automatically switches from telephone calling to fax reception by detecting the fax signal (CNG signal) when you lift the handset of the telephone or the answering machine answers. When you have an answering machine connected to the machine, select ON to switch to fax reception automatically after the answering machine answers.
  If you select OFF, the machine does not switch from telephone calling to fax reception automatically even if the machine detects the fax signal (CNG signal). Select OFF if you want the machine not to switch automatically during a call.

Note

- If you subscribe to Duplex Ringing service in Hong Kong, the number of times the external device rings specified with Incoming ring in FAX only mode is available in TEL priority mode.
If you want to specify the number of times the external device rings in **TEL priority mode**, select **FAX only mode** on the **Receive mode settings** screen, specify the number of times the external device rings with **Incoming ring**, then switch to **TEL priority mode** on the **Receive mode settings** screen.

- If you subscribe to Duplex Ringing service in Hong Kong, we recommend that **Manual/auto switch** be set to **OFF**.

**Advanced setting in FAX only mode**
You can specify the following setting item.

- **Incoming ring**
  You can specify the number of times the external device rings when incoming.

**Advanced setting in DRPD**
You can specify the following setting items.

- **DRPD: FAX ring pattern**
  Sets the distinctive ring pattern of a call that the machine assumes is a fax call.
  If you subscribe to a DRPD service, set the ring pattern to match the pattern assigned by your telephone company.
- **Incoming ring**
  You can specify the number of times the external device rings when incoming.

**Advanced setting in Network switch**
You can specify the following setting item.

- **Incoming ring**
  You can specify the number of times the external device rings when incoming.
Memory Reception

If the machine was not able to print the received fax, the received fax is stored in the machine’s memory. The FAX Memory lamp is lit and Received in memory, is displayed on the LCD.

Important

- If the power plug is disconnected, all faxes stored in the machine’s memory are deleted. The next time you turn the machine on, press the OK button after a confirmation screen is displayed. The list of the faxes deleted from the machine’s memory (MEMORY CLEAR REPORT) will be printed.

If the machine receives a fax under one of the following conditions, the received fax will be automatically stored in the machine’s memory.

• The machine is set to store received faxes in its memory:
  
  When Do not print is selected for Received documents in Auto print settings under FAX settings, the received faxes are stored in the machine’s memory.
  
  You can print the faxes stored in the machine’s memory from the Memory reference screen in the Fax menu.

  ➤ Printing a Document in Machine’s Memory

  ➤ Note

  - To print the received faxes automatically, select Print for Received documents in Auto print settings under FAX settings.

• An error has occurred on the machine:

  If you select Print for Received documents in Auto print settings under FAX settings, a received fax will be printed automatically. However, if any of the following errors occurs, the received fax will not be printed. It will instead be stored in the machine’s memory.

  When the error is resolved, the fax stored in the machine’s memory is printed automatically.

  • The amount of remaining ink is insufficient to print a fax:
    Replace the ink tank.
    ➤ Replacing an Ink Tank

  ➤ Note

  - You can set the machine to forcibly print a received fax even if the ink has run out. Set Print when out of ink in Auto print settings under FAX settings to Print.
    - However, part or all of the fax may not be printed since the ink has run out.
    - Also, the contents of the fax will not be stored in the machine’s memory.
    - If the ink has already run out, we recommend that Do not print be selected for Received documents in Auto print settings under FAX settings to store the received fax in the machine’s memory. After you replace the ink tank and select Print for Received documents in Auto print settings, the fax stored in the machine’s memory will be printed automatically.

  ➤ Auto print settings

  • Paper has run out:
    Load the paper and press the OK button.

  • A different size of paper from that specified by Page size is loaded:
    Load the same size of paper as that specified by Page size, then press the OK button.

• You pressed the Stop button to cancel printing of a fax:

  Press the FAX button to resume printing of the fax.

  ➤ Note

  - The machine can store up to max. 250 pages* (max. 30 documents) of faxes in the machine’s memory.
  
  - When using ITU-T No.1 chart (Standard mode)

  - If the machine’s memory becomes full during memory reception, only pages which already have been received are stored in the memory. Print the received faxes stored in the machine’s memory or save
them on the USB flash drive, delete them from the machine's memory, and have the sender resend the faxes.

Document Stored in Machine's Memory
Receiving Faxes Using Useful Functions

- Saving Received Faxes Automatically on a USB Flash Drive
- Remote Reception
- Rejecting Fax Reception
- Using the Caller ID Service to Reject Calls
Saving Received Faxes Automatically on a USB Flash Drive

You can save received faxes on a USB flash drive as PDF files automatically when receiving a fax. This section describes the procedure to enable the machine to save received faxes on a USB flash drive automatically.

**Important**
- Do not remove the USB flash drive from the machine when the machine is set to save received faxes on a USB flash drive automatically.
- For safety reasons, we recommend backing up faxes saved on a USB flash drive to another media periodically to avoid unexpected accidents.
- We assume no responsibility for damage to or loss of data for whatever reason even within the warranty period.
- **Awaiting document processing.** is displayed on the LCD and the faxes are stored in the machine's memory when the received faxes are not saved on the USB flash drive because the USB flash drive is not inserted or because it is not writable.
- You can save the faxes stored in the machine's memory to the USB flash drive manually. Delete the unnecessary fax from machine's memory after saving to the USB flash drive.

1. Make sure that the machine is turned on.
   - **Confirming that the Power Is On**

2. Insert the USB flash drive into the USB flash drive port.
   - **Inserting the USB Flash Drive**

3. Press the **MENU** button.
   - The menu screen is displayed.

4. Select **Setup**, then press the **OK** button.

5. Select **Device settings**, then press the **OK** button.

6. Use the **▼** button to select **FAX settings**, then press the **OK** button.

7. Use the **▼** button to select **Auto save setting**, then press the **OK** button.

8. Use the **▼** button to select **ON**, then press the **OK** button.

**Note**
- You can save up to 250 pages of fax as one PDF file.
- You can save up to 2000 PDF files on a USB flash drive.
- If the USB flash drive is removed or becomes full while saving faxes is in progress, the error message is displayed on the LCD. Press the **OK** button to dismiss the error.
- The folder and file name of faxes saved on the USB flash drive is as follows:
  - **Folder name:** CANON_SC/FAXDOC/0001
  - **File name (file extension: PDF):** Running numbers, starting from FAX_0001
  - **File date:** The date and time of saving as set in the machine.
  - For details on how to set the date and time:
    - **Setting the Date and Time**
  - **When removing the USB flash drive, set Auto save setting to OFF.**

- **Saving a Document in Machine's Memory to USB Flash Drive**
- **Deleting a Document in Machine's Memory**
Importing Faxes Saved on a USB Flash Drive to the Computer
You can import faxes saved on a USB flash drive to the computer.
After saving faxes, connect the USB flash drive to the computer, then import the data.
Remote Reception

If the machine is located away from the telephone, pick up the handset of the telephone connected to the machine and dial 25 (the remote reception ID) to receive faxes (remote reception).

- If you use a rotary pulse line, temporarily switch your telephone to tone dialing. For details on how to switch to tone dialing, refer to your telephone’s instruction manual.
- If you have an answering machine connected to the machine that can carry out remote control operations, the security code for this function may be the same as the remote reception ID. In this case, change the remote reception ID in Remote RX ID in Remote RX in Advanced FAX settings under FAX settings.

Remote reception can be disabled.
Rejecting Fax Reception

You can set the machine to reject faxes with no sender information or those from specific senders.
Select one of the following conditions to reject faxes.
- Faxes with no caller identification.
- Faxes from senders not registered to the coded speed dial codes.
- Faxes from senders registered in the machine as rejected numbers.

Select a fax rejection condition following the procedure below.

1. Make sure that the machine is turned on.

Confirming that the Power Is On

2. Press the MENU button.

The menu screen is displayed.

3. Select Setup, then press the OK button.

4. Select Device settings, then press the OK button.

5. Use the ▲▼ button to select FAX settings, then press the OK button.

6. Use the ▲▼ button to select Security control, then press the OK button.

7. Use the ▲▼ button to select FAX reception reject, then press the OK button.

8. Use the ▲▼ button to select ON, then press the OK button.

9. Use the ▲▼ button to select the fax rejection condition, then press the OK button.

No sender info.
Rejects faxes with no caller identification.

Coded dial unset
Rejects faxes from the senders not registered to coded speed dial codes.

Rejected numbers
Rejects faxes from the senders registered in the machine as rejected numbers.
For details on how to register the rejected number, see Registering the Rejected Number.

Note

- When the machine rejects reception, Reception rejected, is displayed on the LCD.
- Faxes with no caller identification are also rejected when the setting other than No sender info. is selected.

Registering the Rejected Number

Register the rejected number following the procedure below.

1. When the confirmation screen to register the rejected number is displayed, use the ▲▼ button to select Yes, then press the OK button.
2. Use the ▲▼ button to select the dial code to register, then press the OK button.

3. Use the ▲▼ button to select a registration method, then press the OK button.
   Register the rejected number depending on the registration method.
   - **Direct entry**
     When you select this registration method, the screen to register the fax/telephone number is displayed.

   ![Rejected number 01](image)

   The screen to enter the fax/telephone number is displayed when you press the OK button. Enter the fax/telephone number you want to register, then press the left Function button.
   - **From outgoing call log**
     When you select this registration method, the screen to select the fax/telephone number from the outgoing call logs is displayed.

   ![From outgoing call log](image)

   Use the ▲▼ button to select a fax/telephone number, then press the OK button.
   - **From incoming call log**
     When you select this registration method, the screen to select the fax/telephone number or the name from the incoming call logs is displayed.

   ![From incoming call log](image)

   Use the ▲▼ button to select a fax/telephone number or a name, then press the OK button.

   **Note**
   - This registration method may not be available depending on the country or region of purchase.

4. Press the left Function button to finalize registration.

   **Note**
   - To register another rejected number, use the ▲▼ button to select another dial code, then register the rejected number.
You can register up to 10 rejected numbers.  
- You can print the list of rejected numbers (REJECTED NUMBER LIST).

**Summary of Reports and Lists**

- **To change the registered rejected number:**
  - Select a registered rejected number you want to change, then press the **OK** button.
  - Use the **▲▼** button to select **Edit**, then press the **OK** button.
  - The screen to change the registered rejected number is displayed.
  - Change the registered rejected number in the same procedure when you register.
  - Finalize registration in the same procedure when you register.

- **To delete the registered rejected number:**
  - Select a registered rejected number you want to delete, then press the **OK** button.
  - Use the **▲▼** button to select **Delete**, then press the **OK** button.
  - The confirmation screen is displayed.
  - Use the **▲▼** button to select **Yes**, then press the **OK** button.

- You can register the rejected number in **Rejected numbers** under **TEL number registration** in the Fax menu.
Using the Caller ID Service to Reject Calls

If you subscribe to the Caller ID service, the machine detects the sender's Caller ID. If the sender's ID matches the condition specified in this setting, the machine rejects the phone call or fax reception from the sender.

**Note**

- This setting may not be supported depending on the country or region of purchase. Contact your telephone company to confirm whether it provides this service.

Specify the setting following the procedure below.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the **MENU** button.
   - The menu screen is displayed.

3. Select **Setup**, then press the **OK** button.

4. Select **Device settings**, then press the **OK** button.

5. Use the **▲▼** button to select **FAX settings**, then press the **OK** button.

6. Use the **▲▼** button to select **Security control**, then press the **OK** button.

7. Use the **▲▼** button to select **Caller rejection**, then press the **OK** button.

8. Use the **▲▼** button to select **Yes**, then press the **OK** button.
   - The **Caller rejection conditions** screen is displayed.

9. Specify the rejection conditions.
   - Use the **▲▼** button to select a setting item and use the **◄►** button to select **Accept** or **Reject**.

   **Anonymous no.**
   - Selects whether to reject a phone call or fax reception from an anonymous number.

   **Out of area no.**
   - Selects whether to reject a phone call or fax reception out of the subscribed service area.

   **Rejected numbers**
   - Selects whether to reject a phone call or fax reception from the specified numbers.

10. Press the **OK** button to finish specifying the rejection conditions.
    - If you select **Reject** for **Rejected numbers**, **Register rejected numbers?** is displayed on the LCD.
    - Use the **▲▼** button to select **Yes**, then register the rejected number.
    - For details on how to register the rejected number, see **Registering the Rejected Number**.

**Note**

- Even if you select **Reject**, the machine rings once.
  - (The machine may not ring depending on the country or region of purchase.)
Other Useful Fax Functions

- Using the Information Services
- Transmission/Reception of Faxes Using ECM
- Document Stored in Machine's Memory
- Summary of Reports and Lists
Using the Information Services

You can use various information services such as provided by banks, and make airline reservations or hotel reservations. Since these services require tone dialing to use their services, you need to temporarily switch to tone dialing if your machine is connected to a rotary pulse line.

➤ Using the Touch Tone Line
➤ Using the Rotary Pulse Line

Important

You may need to contract with the service providers for some information services. For details, contact the service providers.

Using the Touch Tone Line

• Dialing by Using the Hook Button

➤ Note

You can use the Hook button only when Hook key setting in Security control under FAX settings is set to Enable.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the Hook button.

4. Use the Numeric buttons to dial the number of the information service.

5. When the recorded message for the information service answers, use the Numeric buttons to press the numbers in accordance with the message.

6. Press the Hook button to finish using the service.

• Dialing by Using the Telephone Connected to the Machine

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Lift the handset of the telephone.

4. Use the telephone to dial the number of the information service.

5. When the recorded message for the information service answers, use the telephone to press the numbers in accordance with the message.
6. Hang up the handset to finish using the service.

### Using the Rotary Pulse Line

- **Dialing by Using the Hook Button**

  ![Note](image)

  | You can use the Hook button only when Hook key setting in Security control under FAX settings is set to Enable. |

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the FAX button.
   - The Fax standby screen is displayed.

3. Press the Hook button.

4. Use the Numeric buttons to dial the number of the information service.

5. When the recorded message for the information service answers, press the Tone button to switch to tone dialing.

6. Use the Numeric buttons to press the numbers in accordance with the message.

7. Press the Hook button to finish using the service.

- **Dialing by Using the Telephone Connected to the Machine**

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the FAX button.
   - The Fax standby screen is displayed.

3. Lift the handset of the telephone.

4. Use the telephone to dial the number of the information service.

5. When the recorded message for the information service answers, use the telephone to switch to tone dialing.
   - When you dial the number of the information service using the telephone connected to the machine, you cannot use the machine to switch to tone dialing. For instructions on how to switch to tone dialing, refer to your telephone's instruction manual.

6. Use the telephone to press the numbers in accordance with the message.

7. Hang up the handset to finish using the service.
Transmission/Reception of Faxes Using ECM

This machine is set to send/receive faxes in Error Correction Mode (ECM). If the recipient's fax machine is compatible with ECM, ECM automatically corrects errors and resends the fax.

Note

- If the sender's or recipient's fax machine is not compatible with ECM, the fax will be sent/received without automatic error correction.
- To receive color faxes, make sure that ECM RX in Adv. communication settings in Advanced FAX settings under FAX settings is set to ON.
- Advanced FAX settings
  To disable ECM transmission/reception, set ECM TX and ECM RX in Adv. communication settings to OFF.
- Transmission may take longer when ECM is enabled.
Document Stored in Machine's Memory

If the sending faxes is not complete or the machine was not able to print the received faxes, these faxes are stored in the machine's memory.

If an error occurred during a fax transmission, the document is not stored in the machine's memory.

In the following cases, the machine is not able to print the received fax and will automatically store the fax in its memory.

- The amount of remaining ink is insufficient to print a fax.
- Paper has run out.
- A different size of paper from that specified by Page size is loaded.
- Do not print is selected for Received documents in Auto print settings under FAX settings.
- You pressed the Stop button to cancel printing of a received fax.

Important

- If you unplug the power cord of the machine, all faxes stored in the machine's memory are deleted. For details on how to unplug the power cord, refer to Notice for Unplugging the Power Cord.

You can print or delete the faxes stored in the machine's memory. You can also save the received faxes stored in the machine's memory on the USB flash drive.

- To print a document in the machine's memory: ➤ Printing a Document in Machine’s Memory
- To delete a document in the machine's memory: ➤ Deleting a Document in Machine's Memory
- To save a document on a USB flash drive ➤ Saving a Document in Machine’s Memory to USB Flash Drive

Note

- When confirming, printing, or deleting a document stored in the machine's memory, you specify it by its transaction number. If you do not know the transaction number for your target document, print the list of documents (MEMORY LIST) first. For details on how to print MEMORY LIST, see Printing a List of the Document in Machine's Memory.
Printing a Document in Machine's Memory

You can print a specified document in the machine's memory or print all the documents in its memory at a time.

When printing a specified document, you specify it by its transaction number. If you do not know the transaction number for your target document, print the list of documents (MEMORY LIST) first.

- Printing a List of the Document in Machine's Memory
- Printing a Specified Document in Machine's Memory
- Printing All the Documents in Machine's Memory

**Note**

- MEMORY LIST shows the transaction number of the unsent or unprinted fax (TX/RX NO.), transaction mode, recipient's number, and the date and time of the transaction.

Printing a List of the Document in Machine's Memory

Print the list of the documents (MEMORY LIST) following the procedure below.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Load paper.
   - Loading Paper

3. Press the FAX button.
   - The Fax standby screen is displayed.

4. Press the left Function button.
   - The Fax menu screen is displayed.

5. Select Memory reference, then press the OK button.

   **Note**

   - If no document is stored in the machine's memory, **There is no document in memory.** is displayed. Press the OK button to return to the previous screen.

6. Use the ▲▼ button to select Print memory list, then press the OK button.

7. Use the ▲▼ button to select Yes, then press the OK button.
   - The list of documents stored in the machine's memory is printed.

   **Note**

   - A transaction number from "0001" to "4999" indicates a document being sent. A transaction number from "5001" to "9999" indicates a document being received.

Printing a Specified Document in Machine's Memory

Specify the document and print it following the procedure below.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On
2. Load paper.

- Loading Paper

3. Press the **FAX** button.

   The Fax standby screen is displayed.

4. Press the left **Function** button.

   The Fax menu screen is displayed.

5. Select **Memory reference**, then press the **OK** button.

   **Note**

   If no document is stored in the machine's memory, **There is no document in memory** is displayed. Press the **OK** button to return to the previous screen.

6. Use the **▲▼** button to select **Print specified document**, then press the **OK** button.

   The document selection screen is displayed.

   ![Document Selection Screen]

   A. Date and time of transaction and fax/telephone number
   
   B. Transaction number (TX/RX NO.)
   
   - A transaction number from "0001" to "4999" indicates a document being sent.
   
   - A transaction number from "5001" to "9999" indicates a document being received.
   
   C. Color information
   
   - **Color** is displayed for color transmission/reception. Nothing is displayed for black & white transmission/reception.

7. Use the **▲▼** button to select the transaction number of the document you want to print, then press the **OK** button.

   The confirmation screen is displayed.

8. Use the **▲▼** button to select whether to print only the first page of the document, then press the **OK** button.

   - If you select **Yes**:
     
     Only the first page of the document will be printed.
     
     The document is still stored in the machine's memory.
   
   - If you select **No**:
     
     All pages of the document will be printed.
     
     The screen to confirm whether to delete the printed document in the machine's memory is displayed.
     
     If you select **Yes** using the **▲▼** button and press the **OK** button, the printed document in the machine's memory is deleted.

   **Note**

   If there are no documents stored in the machine's memory, **There is no document that can be printed** is displayed. Press the **OK** button to return to the previous screen.
Printing All the Documents in Machine's Memory
Print all the documents in the machine's memory following the procedure below.

1. Make sure that the machine is turned on.
   ➤ Confirming that the Power Is On

2. Load paper.
   ➤ Loading Paper

3. Press the FAX button.
   The Fax standby screen is displayed.

4. Press the left Function button.
   The Fax menu screen is displayed.

5. Select Memory reference, then press the OK button.
   ➤ Note
   If no document is stored in the machine's memory, There is no document in memory is displayed. Press the OK button to return to the previous screen.

6. Use the ▲▼ button to select Print all received documents, then press the OK button.
   The confirmation screen is displayed.

7. Use the ▲▼ button to select Yes, then press the OK button.
   All the documents in the machine's memory will be printed.
   Each time a document is printed, the screen to confirm whether to delete the printed document in the machine's memory is displayed.
   If you select Yes using the ▲▼ button and press the OK button, the printed document in the machine's memory is deleted.
Deleting a Document in Machine's Memory

You can delete a specified document in the machine's memory or delete all the documents in its memory at a time.

- Deleting a Specified Document in Machine's Memory
- Deleting All the Documents in Machine's Memory

**Note**

- When deleting a specified document, you specify it by its transaction number. If you do not know the transaction number for your target document, print the list of documents (MEMORY LIST) first.

Deleting a Specified Document in Machine's Memory

Specify the document and delete it following the procedure below.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Press the FAX button.
   - The Fax standby screen is displayed.

3. Press the left Function button.
   - The Fax menu screen is displayed.

4. Select Memory reference, then press the OK button.

   **Note**

   - If no document is stored in the machine's memory, There is no document in memory. is displayed. Press the OK button to return to the previous screen.

5. Use the ▲▼ button to select Delete specified document, then press the OK button.
   - The document selection screen is displayed.

   ![Delete specified document screen]

   A. Date and time of transaction and fax/telephone number
   B. Transaction number (TX/RX NO.)
      - A transaction number from "0001" to "4999" indicates a document being sent.
      - A transaction number from "5001" to "9999" indicates a document being received.
   C. Color information
      - **Color** is displayed for color transmission/reception. Nothing is displayed for black & white transmission/reception.
6. Use the ▲▼ button to select the transaction number of the document you want to delete, then press the OK button.
   The confirmation screen is displayed.

7. Use the ▲▼ button to select Yes, then press the OK button.
   The specified document will be deleted from machine’s memory.

Note

If there are no documents stored in the machine's memory, There is no document that can be deleted, is displayed. Press the OK button to return to the previous screen.

Deleting All the Documents in Machine's Memory
Delete all the documents in the machine's memory following the procedure below.

1. Make sure that the machine is turned on.
   ➔ Confirming that the Power Is On

2. Press the FAX button.
   The Fax standby screen is displayed.

3. Press the left Function button.
   The Fax menu screen is displayed.

4. Select Memory reference, then press the OK button.

Note

If no document is stored in the machine's memory, There is no document in memory, is displayed. Press the OK button to return to the previous screen.

5. Use the ▲▼ button to select Delete all documents in memory, then press the OK button.
   The confirmation screen is displayed.

6. Use the ▲▼ button to select Yes, then press the OK button.
   All the documents in the machine’s memory will be deleted.
Saving a Document in Machine's Memory to USB Flash Drive

You can save the received faxes stored in the machine's memory to the USB flash drive as PDF files using the operation panel of the machine.

You can save a specified document in the machine's memory to the USB flash drive or save all the documents in its memory to the USB flash drive at a time.

saving a Specified Received Document in Machine's Memory to USB Flash Drive

Saving All the Received Documents in Machine's Memory to USB Flash Drive

Important

- Do not remove the USB flash drive from the machine until saving is complete.
- For safety reasons, we recommend backing up faxes saved on a USB flash drive to another media periodically to avoid unexpected accidents.
- We assume no responsibility for damage to or loss of data for whatever reason even within the warranty period.

Note

- When saving a specified document, you specify it by its transaction number. If you do not know the transaction number for your target document, print the list of documents (MEMORY LIST) first.
  ➪ Printing a List of the Document in Machine's Memory
- After saving the fax in the machine's memory to the USB flash drive, the fax is still stored in the machine's memory.
  For details on how to delete the fax in the machine's memory, see Deleting a Document in Machine’s Memory.

Saving a Specified Received Document in Machine's Memory to USB Flash Drive

Specify the received document and save it on the USB flash drive following the procedure below.

1. Make sure that the machine is turned on.
   ➪ Confirming that the Power Is On

2. Insert the USB flash drive into the USB flash drive port.
   ➪ Inserting the USB Flash Drive

3. Press the FAX button.
   The Fax standby screen is displayed.

4. Press the left Function button.
   The Fax menu screen is displayed.

5. Select Memory reference, then press the OK button.

   Note

   - If no document is stored in the machine's memory, There is no document in memory. is displayed. Press the OK button to return to the previous screen.

6. Use the ▲▼ button to select Save specified document, then press the OK button.
   The document selection screen is displayed.
A. Date and time of transaction and fax/telephone number
B. Transaction number (TX/RX NO.)
   A transaction number from "0001" to "4999" indicates a document being sent.
   A transaction number from "5001" to "9999" indicates a document being received.
C. Color information
   Color is displayed for color transmission/reception. Nothing is displayed for black & white transmission/reception.

7. Use the ▲▼ button to select the transaction number of the document you want to save, then press the OK button.
   The specified document is saved on the USB flash drive.

   Note
   If there are no documents stored in the machine's memory, There is no document that can be saved. is displayed. Press the OK button to return to the previous screen.

Saving All the Received Documents in Machine's Memory to USB Flash Drive
Save all the received documents in the machine's memory to the USB flash drive following the procedure below.

1. Make sure that the machine is turned on.
   Confirming that the Power Is On

2. Insert the USB flash drive into the USB flash drive port.
   Inserting the USB Flash Drive

3. Press the FAX button.
   The Fax standby screen is displayed.

4. Press the left Function button.
   The Fax menu screen is displayed.

5. Select Memory reference, then press the OK button.

   Note
   If no document is stored in the machine's memory, There is no document in memory. is displayed. Press the OK button to return to the previous screen.

6. Use the ▲▼ button to select Save all documents, then press the OK button.

7. When the confirmation screen is displayed, use the ▲▼ button to select Yes, then press the OK button.
   All the documents in the machine's memory will be saved to the USB flash drive.
You can save up to 250 pages of fax as one PDF file.
You can save up to 2000 PDF files on a USB flash drive.
Faxes are saved according to the order of the transaction number when Save all documents is selected.
If the USB flash drive is removed or becomes full while saving faxes is in progress, the error message is displayed on the LCD. Press the OK button to dismiss the error.
The folder and file name of faxes saved on the USB flash drive is as follows:
- Folder name: CANON_SC\FAXDOC\0001
- File name (file extension: PDF): Running numbers, starting from FAX_0001
- File date: The date and time of saving as set in the machine.
For details on how to set the date and time:
  → Setting the Date and Time

• Importing Faxes Saved on a USB Flash Drive to the Computer
You can import faxes saved on a USB flash drive to the computer.
After saving faxes, connect the USB flash drive to the computer, then import the data.
## Summary of Reports and Lists

The machine prints the report of sending or receiving a fax automatically. You can print the list of the fax/telephone number or the current settings.

- Type of Reports and Lists
- Printing Report or List

### Type of Reports and Lists

<table>
<thead>
<tr>
<th>Report or List</th>
<th>Description</th>
</tr>
</thead>
</table>
| ACTIVITY REPORT                   | Shows recent fax transactions at sight.  
  • You can print ACTIVITY REPORT manually.  
  For details on the procedure to print, see Printing Report or List.  
  • The * (asterisk) is appended to the history already printed on ACTIVITY REPORT.  
  • If you select Print for Activity report in Auto print settings under FAX settings, the machine prints ACTIVITY REPORT for the 20 histories of sent and received faxes automatically.  
  ➤ Auto print settings                                                                 |
| Telephone number list             | Lists the numbers and names registered.  
  You can print the list for coded speed dial and group dial.  
  For details on the procedure to print, see Printing Report or List.                                                                                       |
| CODED SPEED DIAL TELEPHONE NO. LIST |                                                                                                           |                                                                                                                                                                                                                             |
| GROUP DIAL TELEPHONE NO. LIST    |                                                                                                                                                                                                                             |                                                                                                                                                                                                                             |
| USER'S DATA LIST                 | Lists the current settings of the machine and the registered sender information.  
  For details on the procedure to print, see Printing Report or List.                                                                                           |                                                                                                                                                                                                                             |
| MEMORY LIST                      | Lists the documents currently stored in the machine's memory.  
  For details on the procedure to print, see Printing Report or List.                                                                                           |                                                                                                                                                                                                                             |
| Note                             | You can print MEMORY LIST by selecting Print memory list in Memory reference in the Fax menu.  
  ➤ Printing a List of the Document in Machine's Memory                                                                                                         |                                                                                                                                                                                                                             |
| REJECTED NUMBER LIST             | Lists the rejected numbers.  
  For details on the procedure to print, see Printing Report or List.                                                                                           |                                                                                                                                                                                                                             |
| CALLER HISTORY                   | Lists the caller history.  
  This list is available when Caller ID service is subscribed.  
  For details on the procedure to print, see Printing Report or List.  
  This list may not be supported depending on the country or region of purchase.                                                                               |                                                                                                                                                                                                                             |
| TX REPORT/ERROR                   | Either of these reports is printed after each fax transmission.  
  • At the time of purchase, ERROR TX REPORT is set to be printed only when a transmission error occurred.  
  You can set the machine to print TX REPORT each time it sends a document, or disable printing of the report by selecting TX report in Auto print settings under FAX settings.  
  You can also specify the print setting so that the first page of the fax is printed along with the report.  
  ➤ Auto print settings                                                                    |
| TX REPORT                         |                                                                                                           |                                                                                                                                                                                                                             |
| TX ERROR REPORT                   |                                                                                                           |                                                                                                                                                                                                                             |

**Note**

- The first page of the fax is not printed in color transmission.
- MULTI TRANSMISSION REPORT is printed after sequential broadcasting of a document.
If an error occurs when you send a fax, the error number is printed on ERROR TX REPORT (there are some errors for which the cause is also printed). For details on the error number, see Errors When You Send a Fax.

MULTI TRANSMISSION REPORT

This report is printed after sequential broadcasting of a document. Confirms whether the transmission to all the recipients has been completed successfully. The procedure to print and the error number is same as TX REPORT.

RX REPORT

This report is printed after each fax reception.

- At the time of purchase, the machine is set so that RX REPORT is not printed at all.
- You can set the machine to print RX REPORT each time it receives a document, or only when an error occurs by selecting RX report in Auto print settings under FAX settings.
- Auto print settings
- If an error occurs when you receive a fax, the error number is printed on RX REPORT (there are some errors for which the cause is also printed). For details on the error number, see Errors When You Receive a Fax.

MEMORY CLEAR REPORT

Lists the deleted faxes in the machine’s memory if the faxes stored in the machine’s memory are deleted by a power failure or unplugging the power cord. When the machine is turned on, The power cord has been unplugged and unsent/received docs in memory have been lost. Load paper and select OK to print a list of the lost docs. is displayed on the LCD. MEMORY CLEAR REPORT is printed by pressing the OK button.

Printing Report or List

This section describes the procedure to print the report or the list manually.

Print the following report or list manually.

- ACTIVITY REPORT
- Telephone number list (CODED SPEED DIAL TELEPHONE NO. LIST/GROUP DIAL TELEPHONE NO. LIST)
- USER'S DATA LIST
- MEMORY LIST
- REJECTED NUMBER LIST
- CALLER HISTORY

Note

CALLER HISTORY may not be supported depending on the country or region of purchase.

1. Make sure that the machine is turned on.
   - Confirming that the Power Is On

2. Load paper.
   - Loading Paper

3. Press the FAX button.
   - The Fax standby screen is displayed.

4. Press the left Function button.
   - The Fax menu screen is displayed.

5. Select Print reports/lists, then press the OK button.

6. Use the ▲▼ button to select the report or list you want to print, then press the OK button.
   - When you select Telephone number list:
     - Use the ▲▼ button to select Coded speed dial or Group dial, then press the OK button.
If you select **Coded speed dial**, select whether to print CODED SPEED DIAL TELEPHONE NO. LIST in alphabetical order of the registered names, then press the **OK** button. If you select **Yes**, the machine prints CODED SPEED DIAL TELEPHONE NO. LIST with the destination names in alphabetical order. If you select **No**, the machine prints CODED SPEED DIAL TELEPHONE NO. LIST with the registered entries in numerical order.

If you select **Group dial**, the confirmation screen is displayed. Select **Yes**, then press the **OK** button. The machine prints GROUP DIAL TELEPHONE NO. LIST.

- When you select an item other than **Telephone number list**:
  The confirmation screen is displayed. Select **Yes**, then press the **OK** button.
  The machine prints the selected report or list.

### Errors When You Send a Fax

If an error occurs when you send a fax, the error number is printed on ERROR TX REPORT (there are some errors for which the cause is also printed).

The causes corresponding to the error numbers are as follows.

<table>
<thead>
<tr>
<th>No.</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>#001</td>
<td>Document is jammed in the ADF.</td>
<td>The document is jammed in the ADF. When the error is cleared, redo the operation.</td>
</tr>
<tr>
<td>#003</td>
<td>Document is too long.</td>
<td>You attempted to send a document longer than 15.75 inches / 400 mm. You cannot send a document longer than 15.75 inches / 400 mm from the ADF. &quot;#003&quot; is also printed if it takes time to send a page. Divide the document or set the image quality (Fax resolution) to a lower setting, then resend it.</td>
</tr>
<tr>
<td>#005</td>
<td>No answer.</td>
<td>The recipient's fax machine does not respond. Contact the recipient and have the recipient check that the telephone line is connected correctly.</td>
</tr>
<tr>
<td>#012</td>
<td>No paper is in the recipient's fax machine.</td>
<td>There is no paper in the recipient's fax machine. Contact the recipient and have the recipient load paper.</td>
</tr>
<tr>
<td>#017</td>
<td>No tone is detected.</td>
<td>The machine could not detect the dial tone. <strong>Dial tone detect</strong> in <strong>Advanced FAX settings</strong> under <strong>FAX settings</strong> is set to <strong>ON</strong>. Set to <strong>OFF</strong>. ➤ <strong>Advanced FAX settings</strong></td>
</tr>
<tr>
<td>#018</td>
<td>Line was busy.</td>
<td>The fax/telephone number you dialed is busy. Try dialing again after waiting for a moment.</td>
</tr>
<tr>
<td>#022</td>
<td>Number is deleted.</td>
<td>The fax/telephone number registered to the speed dial is incorrect. Check the recipient's fax/telephone number, correct the fax/telephone number registered to the speed dial code, then send the document again. ➤ <strong>Changing Registered Information</strong></td>
</tr>
<tr>
<td>#037</td>
<td>Memory is full.</td>
<td>The machine could not send a fax because its memory is full. Delete contents in memory, then send a fax again. ➤ <strong>Document Stored in Machine's Memory</strong></td>
</tr>
<tr>
<td>#059</td>
<td>Transmission has been canceled due to a fax information mismatch.</td>
<td>Transmission has been canceled because the machine could not detect the recipient's fax machine information or the information did not match the dialed number. This message is displayed when <strong>Check RX FAX information</strong> in <strong>Security control</strong> under <strong>FAX settings</strong> is set to <strong>ON</strong>. For details, see <strong>Sending Faxes after Checking Information (Checking the Recipient's Information)</strong>.</td>
</tr>
<tr>
<td>#085</td>
<td>Try again in black &amp; white transmission.</td>
<td>The recipient's fax machine is not color-compatible. Resend the document in black &amp; white.</td>
</tr>
<tr>
<td>#099</td>
<td>The <strong>Stop</strong> button was pressed during transmission.</td>
<td>The <strong>Stop</strong> button was pressed to cancel transmission of the document. Resend it if necessary.</td>
</tr>
</tbody>
</table>
The fax could not be sent from the computer. (Windows only).
Ensure that the machine is connected with the computer correctly and redo operation.

### Errors When You Receive a Fax

If an error occurs when you receive a fax, the error number is printed on RX REPORT (there are some errors for which the cause is also printed).

The causes corresponding to the error numbers are as follows.

<table>
<thead>
<tr>
<th>No.</th>
<th>Cause</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>#003</td>
<td>It takes too long to receive a page.</td>
<td>Contact the sender and have the sender divide the fax or set the image quality (Fax resolution) to a lower setting and resend it.</td>
</tr>
<tr>
<td>#005</td>
<td>No answer.</td>
<td>When receiving a fax manually, the machine could not detect the signals from the sender’s fax machine. Contact the sender and have the sender resend it, or set the machine to receive the fax automatically.</td>
</tr>
<tr>
<td>#037</td>
<td>Memory is full.</td>
<td>The machine could not receive a fax because its memory is full. Delete contents in memory, then ask the sender to resend the fax. See Document Stored in Machine’s Memory.</td>
</tr>
<tr>
<td>#046</td>
<td>Reception has been rejected due to the specified fax rejection condition.</td>
<td>Reception has been rejected because the fax matches the fax rejection condition specified by FAX reception reject in Security control under FAX settings. For details, see Rejecting Fax Reception.</td>
</tr>
<tr>
<td>#099</td>
<td>The Stop button was pressed during reception.</td>
<td>The Stop button was pressed to cancel reception of the fax. Contact the sender and have the sender resend it if necessary.</td>
</tr>
</tbody>
</table>
Sending Faxes from a Computer

- Sending a FAX (Fax Driver) 🌐 Basic
- Creating an Address Book (Fax Driver)
- Edit or Remove a Recipient from an Address Book (Fax Driver)
- Search for a Recipient in an Address Book (Fax Driver)
- Troubleshooting Problems Sending Faxes (Fax Driver)
- General Notes (Fax Driver)
Sending a FAX (Fax Driver)

You can send faxes using the fax driver from applications that support document printing.

Note

- Only black and white transmission is supported.

1. Make sure that the machine is turned on.

2. Open the document you want to fax with an application (such as Notepad), and then click the Print command. (The command is Print... on the File menu.)

3. In Select Printer or Name in the Print dialog box, select Canon XXX series FAX (where "XXX" is the model name).

4. Click Print or OK.

* Print dialog box in Notepad

Note

- You can specify the paper size and print orientation by clicking Preferences or Properties in the Print dialog box.
- You can also specify the paper size and print orientation in the dialog box displayed by following the instructions below:
  - Windows 7:
    1. From the Start menu, select Control Panel > Hardware and Sound > Devices and Printers.
    2. Right-click the Canon XXX series Printer icon and select Printing Preferences, then Canon XXX series FAX. Or right-click the Canon XXX series FAX icon and select Printing Preferences. (Where "XXX" is the model name.)
  - Windows Vista:
    1. From the Start menu, select Control Panel > Hardware and Sound > Printers.
    2. Right-click the Canon XXX series FAX icon (where "XXX" is the model name) and select Printing Preferences.
  - Windows XP:
    1. From the Start menu, select Control Panel > Printers and Other Hardware > Printers and Faxes.
    2. Right-click the Canon XXX series FAX icon (where "XXX" is the model name) and select Printing Preferences.
5. Click **Display Address Book...** in **Set Recipient** in the **Send FAX** dialog box.

6. Select a recipient from **Recipient Name** in the **Select Recipient from Address Book** dialog box, then click **Set as Recipient**.
   The selected recipient is reflected in **Recipient** in the **Send FAX** dialog box.

---

**Important**

- You cannot specify a recipient if there is no recipient registered in the address book. Register the recipient in the address book and reopen the address book.
- For details on how to register recipients in the address book, see "Creating an Address Book (Fax Driver)."
- If the recipient's fax/telephone number is entered incorrectly or the registered fax/telephone number is incorrect, the fax may be sent to an unexpected recipient. When sending an important fax, it is recommended that you send it after confirming the entered information and recipient's status.

**Note**

- You can also specify **Recipient** by entering a recipient as follows:
  Enter the **Recipient Name** and **Fax Number** in **Direct Entry** in the **Send FAX** dialog box, then click **Set as Recipient**.
  - For details on valid characters, see "General Notes (Fax Driver)."
  - You can send faxes even if only the **Fax Number** is entered.
  - You can register the recipient you entered to the address book by clicking **Add to Address Book**....
  - For details on how to register recipients in the address book, see "Creating an Address Book (Fax Driver)."
- Add the outside line access number before the fax number as needed.
7. Click **Send Now**.
   When a confirmation message is displayed, click **OK**.

![Image of successful fax transmission with name and fax number]

**Important**
If you cannot send a fax due to line failure, etc., see "Troubleshooting Problems Sending Faxes (Fax Driver)."

**Canceling Transmission**
If you click **Send Now** in the **Send FAX** dialog box, the printer icon is displayed in the taskbar. Double-click this icon to display the list of fax jobs awaiting transmission or being sent. Right-clicking a job and selecting **Cancel** stops transmission.

![Image of fax job list and cancel option]
Creating an Address Book (Fax Driver)

By using the address book, you can send a fax by simply specifying a recipient from it. You can register the recipient's name, fax number and other information in the address book.

Registering a recipient (WAB contact) in the address book
You can register an individual recipient (Contact) in the address book.

1. From the Start menu, navigate as follows:
   - **Windows 7:**
     From the Start menu, select Control Panel > Hardware and Sound > Devices and Printers.
   - **Windows Vista:**
     From the Start menu, select Control Panel > Hardware and Sound > Printers.
   - **Windows XP:**
     From the Start menu, select Control Panel > Printers and Other Hardware > Printers and Faxes.

2. Open the setting screen of the FAX driver.
   - **Windows 7:**
     Right-click the Canon XXX series Printer icon and select Printing Preferences, then Canon XXX series FAX. Or right-click the Canon XXX series FAX icon and select Printing Preferences. (Where "XXX" is the model name.)
   - **Windows Vista/Windows XP:**
     Right-click the Canon XXX series FAX icon (where "XXX" is the model name) and select Printing Preferences.

3. Click Address Book... in the displayed dialog box.

Opening the Address Book for the First Time (Windows XP)
In Windows XP, when you open the address book for the first time, the Setup Windows Address Book dialog box will be displayed.
**Creating a New Windows Address Book (WAB File) Exclusively for Faxing**

Select **Create a new Windows Address Book file for faxing.**, then click **OK**. You can also change the setting later so as to be able to use another address book.

**Using an Existing Windows Address Book**

Click **Select existing Windows Address Book file.**, select an address book file from the list, then click **OK**.

Using an existing Windows Address Book enables you to share it with other applications that use Windows Address Books.

This option cannot be selected if there is no Windows Address Book file created.

---

**Note**

- In Windows 7/Windows Vista, you can register an individual recipient (Contact) in the address book folder (Windows Contacts) as an address book file (.contact file) which can be used in multiple applications. However, you cannot change the address book you use, as only one address book can be created per user. To open Windows Contacts, select **XXXX (user name)** from the **Start** menu, then double-click **Contacts**.
- For details on how to open the Windows Address Book (the default address book of the operating system), see the help or guide for the applications that use Windows Address Book.
- In Windows XP, you can import the entries from one Windows Address Book file into another, combining both sets of Address Book entries. To import fax recipient contacts in an Address Book file to an existing Address Book file, follow the steps below.
  1. From the **Start** menu, select **Search**.
  2. Click **All files and folders**.
  3. In the file name box, enter ".wab".
  4. Select the **Search hidden files and folders** checkbox in **More advanced options**, then click **Search**.
  5. From the found Windows Address Book files, double-click an existing Windows Address Book file.
  6. In the **File** menu, in **import**, select **Address Book (WAB)**...
  7. Select the Windows Address Book containing fax recipient contacts, then click **Open**. When a completion message appears, click **OK**.

---

4. In the **Address Book** dialog box, click **New**.
5. Click **Contact** in the **New Entry** dialog box, then click **OK**.

![New Entry Dialog Box]

**Note**

For faxing, you can only specify the **Contact** (one recipient). You cannot specify a **Distribution List**.

6. Enter the **First**, **Middle**, and **Last** of the contact in the **Name and E-mail** tab (Name tab when using Windows XP) on the **Properties** dialog box.

The recipient's name will be printed at the top of the fax received by the recipient.

![Taro Yamada Properties]

7. Enter the fax number on the **Home** or **Work** tab, then click **OK**.

An individual recipient (Contact) is registered in the address book.

**Note**

You can also register a recipient by clicking the **Add to Address Book...** button on the **Send FAX** dialog box after entering the recipient.
If you upgrade from Windows XP to Windows Vista, the address book you created in Windows XP may not be reflected in Windows Vista. In this case, open the address book in the following procedure and reflect the information to a new address book.

1. From the Start menu, select Control Panel > Appearance and Personalization > Folder Options.
2. Click the View tab of the Folder Options dialog box, select Show hidden files and folders in Advanced settings, then click OK.
3. From the Start menu, select XXXX (user name), then double-click AppData > Roaming > Canon > MP5 to open the folder.
   The address book will be reflected in Windows Vista automatically.
   Add the outside line access number before the fax number as needed.
   (Example: When the outside line access number is "0" and the fax number is "XXX-XXXX", enter "0XXX-XXXX".)

Related Topic
- Edit or Remove a Recipient from an Address Book (Fax Driver)
- Search for a Recipient in an Address Book (Fax Driver)
Edit or Remove a Recipient from an Address Book (Fax Driver)

You can change the recipients' names, fax numbers and other information, or delete recipients registered in the address book.

**Editing Recipients in an address book**
You can edit the contacts registered in the address book.

1. From the **Start** menu, navigate as follows:
   - **Windows 7:**
     From the **Start** menu, select **Control Panel** > **Hardware and Sound** > **Devices and Printers**.
   - **Windows Vista:**
     From the **Start** menu, select **Control Panel** > **Hardware and Sound** > **Printers**.
   - **Windows XP:**
     From the **Start** menu, select **Control Panel** > **Printers and Other Hardware** > **Printers and Faxes**.

2. Open the setting screen of the FAX driver.
   - **Windows 7:**
     Right-click the **Canon XXX series Printer** icon and select **Printing Preferences**, then **Canon XXX series FAX**. Or right-click the **Canon XXX series FAX** icon and select **Printing Preferences**. (Where “XXX” is the model name.)
   - **Windows Vista/Windows XP:**
     Right-click the **Canon XXX series FAX** icon (where “XXX” is the model name) and select **Printing Preferences**.

3. Click **Address Book...** in the displayed dialog box.

![Address Book dialog box](image)

4. Select the recipient you want to edit from the **Address Book** dialog box, then click **Properties**.
5. Change information as needed on the **Properties** dialog box, then click **OK**.

Removing Recipients from an address book
You can delete the contacts registered in the address book.

1. From the **Start** menu, navigate as follows:
   - **Windows 7**:
     From the **Start** menu, select **Control Panel > Hardware and Sound > Devices and Printers**.
   - **Windows Vista**:
     From the **Start** menu, select **Control Panel > Hardware and Sound > Printers**.
   - **Windows XP**:
     From the **Start** menu, select **Control Panel > Printers and Other Hardware > Printers and Faxes**.

2. Open the setting screen of the FAX driver.
   - **Windows 7**:
Right-click the **Canon XXX series Printer** icon and select **Printing Preferences**, then **Canon XXX series FAX**. Or right-click the **Canon XXX series FAX** icon and select **Printing Preferences**. (Where "XXX" is the model name.)

- **Windows Vista/Windows XP:**
  Right-click the **Canon XXX series FAX** icon (where "XXX" is the model name) and select **Printing Preferences**.

3. Click **Address Book...** in the displayed dialog box.

4. Select the recipient you want to delete from the **Address Book** dialog box, then click **Delete**.

5. When a confirmation message is displayed, click **Yes**.
Search for a Recipient in an Address Book (Fax Driver)

You can search for recipients registered in the address book by name.

1. Open the document you want to fax with an application (such as Notepad), and then click the Print command. (The command is Print... on the File menu.)

2. In Select Printer or Name in the Print dialog box, select Canon XXX series FAX (where "XXX" is the model name).

3. Click Print or OK.

   * Print dialog box in Notepad

4. Click Display Address Book... in Set Recipient in the Send FAX dialog box.

5. Enter the name of the recipient you want to search for in Search by Recipient in the Select Recipient from Address Book dialog box.
   
   If the entered name is found, the recipient will be displayed in the contact list with its name selected.
While the name is selected, click **Set as Recipient** to enter it as the recipient.

---

**Important**

- You cannot search by criteria other than name.
Troubleshooting Problems Sending Faxes (Fax Driver)

Check 1: Is the power turned on?

- You cannot send faxes if the power is turned off. Press the ON button to turn the power on.
- If you disconnected the power cord without turning off the power (one of the buttons on the operation panel is lit), reconnecting it turns on the power automatically.
- If you disconnected the power cord after pressing the ON button to turn off the power (no buttons on the operation panel are lit), reconnect it, then press the ON button to turn on the power.
- If the power was turned off due to power failure, etc., the power is automatically turned on when the power failure is resolved.

Important
- Confirm that all lamps on the operation panel are off before unplugging the power cord, then unplug the power cord. If a power failure occurs or you unplug the power cord, all faxes stored in the machine's memory are deleted.

Note
- If the faxes stored in the machine's memory are deleted by a power failure or unplugging the power cord, the list of the faxes deleted from the machine's memory will be printed after turning the machine on.

Check 2: Is a document being sent from memory or a fax being received into memory?

When the message for the transmission/reception is displayed on the machine's LCD (Liquid Crystal Display), a fax is being sent from/received into machine's memory.

Check 3: Is the telephone line type set correctly?

Check the telephone line type setting and change it as necessary.

Check 4: Is Dial tone detect set to ON?

Resend the fax after a while.
If you still cannot send the fax, select OFF for Dial tone detect in Advanced FAX settings under FAX settings.

Check 5: Is the recipient's fax number correct?

Check the recipient's fax number, then send the document again.

Note
- For details on how to change the recipients registered in the address book, see "Edit or Remove a Recipient from an Address Book (Fax Driver)."

Check 6: Does an error occur during transmission?

- Check if a message is displayed in the computer screen.
- If displayed, check the message, then resolve the error.

Check 7: Does a printer error occur?

Check if a message is displayed on the LCD.
If a support code is displayed, see "Support Code List" for your model from Home of the Online manual.
If no support code is displayed, see "A Message Is Displayed" for your model from Home of the Online manual.
If you are in a hurry, press the Stop button to close the message, then send the fax.
Check 8: Is the telephone line connected correctly?

Reconnect the telephone line cable to the telephone line jack.

If the telephone line is connected correctly, then there is a problem with your telephone line. Contact your telephone company and the manufacturer of your terminal adapter or telephone adapter.
General Notes (Fax Driver)

This fax driver is subject to the following restrictions. Keep the following points in mind when using the fax driver.

• The fax driver may not work correctly when sending a Microsoft Excel 2002 document as a fax with the Allow A4/Letter Paper Resizing option checked in Microsoft Excel 2002. Follow the instructions below to solve the problem:
  1. Click Options... from the Tools menu.

• When using a network compatible printer, you cannot send faxes from multiple computers at the same time. If you try to send a fax from a computer while a fax is being sent from another computer, a message appears and your fax cannot be sent.
Make sure that a fax is not being sent from another computer.

• If you assign the fax driver to the Bluetooth port, you cannot send a fax from the computer.

• You can use the following characters for Fax Number:

<table>
<thead>
<tr>
<th>Character</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 - 9 * #</td>
<td>For use in telephone and fax numbers.</td>
</tr>
<tr>
<td>, . p</td>
<td>To place a pause between numbers.</td>
</tr>
<tr>
<td>P</td>
<td>To place a pause at the end of a sequence of numbers.</td>
</tr>
<tr>
<td>T</td>
<td>Numbers after the T will be sent as a tone signal.</td>
</tr>
<tr>
<td>+ - ( ), space</td>
<td>To make the number easier to read. You cannot insert a space at the front of a number.</td>
</tr>
</tbody>
</table>

*You cannot use ",", "R", "M", or "E".

• You can enter the following number of characters in Recipient Name and Fax Number.
  
Recipient Name: Up to 16 characters
Fax Number: Up to 60 characters
* The number of characters you can enter differs in some regions.

• The fax driver does not work correctly if you uncheck the Enable printer pooling option on the Ports tab of the Canon XXX series FAX Properties dialog box (where "XXX" is the model name).
Check that the option is checked by following the instructions below:
- Windows 7:
  1. From the Start menu, select Control Panel > Hardware and Sound > Devices and Printers.
  2. Right-click the Canon XXX series Printer icon and select Printer Properties, then Canon XXX series FAX. Or right-click the Canon XXX series FAX icon and select Printer Properties. (Where "XXX" is the model name.)
  The Canon XXX series FAX Properties dialog box (where XXX is the model name) appears.
  3. Click the Ports tab.
  Check that the Enable printer pooling option is checked.
- Windows Vista:
  1. From the Start menu, select Control Panel > Hardware and Sound > Printers.
  2. Right-click the Canon XXX series FAX icon (where "XXX" is the model name) and select Properties.
  The Canon XXX series FAX Properties dialog box (where XXX is the model name) appears.
  3. Click the Ports tab.
  Check that the Enable printer pooling option is checked.
- Windows XP:
  1. From the Start menu, select Control Panel > Printers and Other Hardware > Printers and Faxes.
  2. Right-click the Canon XXX series FAX icon (where "XXX" is the model name) and select Properties.
  The Canon XXX series FAX Properties dialog box (where XXX is the model name) appears.
  3. Click the Ports tab.
  Check that the Enable printer pooling option is checked.